MASPECTRAS
Users Guide

In this user guide every page and functionality is described in detail. To work with
MASPECTRAS it is not necessary to read the whole document, because many things work
similar to other sections. To work with MASPECTRAS without neglecting any advantages it
should be sufficient to read the chapters 1, 2, 6 and 7. The rest should serve as look-up for
clarifying ambiguities.
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@ Bioinformatics Graz

|@ (‘3\ @ '[Lr-_: @ @ & logout User data Password Preferences
Sample Generation
Sample Processing M AS P E CT RAS
Mass Spectrometry

MS-Analysis MAss SPECTRometry Analysis System

Management

Developed by:

Jirgen Hartler

Gernot Stocker

Gerhard Thallinger
Ceereena Ubaida Mohien

Erik Kirner
Thomas Burkard
Andreas Scheucher

Robert Rader
Thomas Fuchs
and Alexander Sturn

Scientific Advice:
Karl Mechtler
Jacques Colinge
Zlatko Trajanoski

Release Information:
Version 2.1
Build 20090246,

ﬁTU d i itute for Genomics and E\qnfmnétirs of Technology (IGB-TUG). All rights n ved.
Grazm U o : : o ; o A E

ncluding no representati
Bioinformatics Group y not warant the
Institute for Genomics : witho i patent rights or prop.
and Bioinformatics, Graz
University of Technology

This will be your first impression of MASPECTRAS.
The main view is divided into 3 sections:
1. The header section consists of some images on the top, of one bar concerning the
display and one bar concerning the AAS(Authentication and Authorization
System)
2. The left side bar contains the menu
The centre frame contains the displayable information

(98]



1.1 The header section:

%, Bioinformatics Graz

DO® OO @ ndn | please login

1.1.1 The display bar:

Home @ E

The “Home”-link leads you back to the start page.
At the right side there are 3 icons where you can change the spatial usage of the browser
window:

: brings the window back to the normal size (default setting)

: with this link you can use the full width of your screen for displaying the information
section

E : uses the full width of the window and the images at the header section disappear, only
the display bar and the AAS bar will stay.

1.1.2 The menu administration bar:

Dee =08

This bar allows the customization of the menu bars. The icons which come after l@' change
the settings of the normal menu while the icons which come after = change the settings of the
tree menu. The meaning of the symbols is the same:

e : this removes the menu bar on the left side of the screen so that all of the space is
available for the main information page:
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logout | Userdata | Password

Welcome to MASPECTRAS

User name:

Full name:

Email address:
Institute name:
Valid since:
Valid until:

Last login date:
Last login realm:

Password expires:

Server Name:
Server Port:
Scheme:
Secure

hartler

Juergen Hartler
juergen.harler@tugraz. at
Bioinformatics Graup

Sat Cct0912:28:37 CEST 2004
Thu Dec 31 12:28:37 CET 20049
14.48.40:14.02.2008
maspectras

never

localhost

a0an

hitp

false

Header Elements

accept

| Preferences

imanelgif, imagek-xhitman, imagelipen, imagefpjped, application

. this shows a menu bar again on the left side (here the tree menu is shown):

Elv]a = Ok

g

r

Experiments

r P anathersubMNode

r I test ShowinTree

logout | Userdata | Password |

Preferences |

Welcome to MASPECTRAS

User name: hartler
Full name:

Email address:

Juergen Hartler
juergen.harlerg@tugraz.at

Institute name: Bioinformatics Group

Valid since: Sat Oct 09 12:28:37 CEST 2004
Yalid until: Thu Dec 31 12:28:37 CET 20049
Last login date: 14.48.40:14.02.2008

Last login realm: maspectras

Password expires: never

Senver Name: localhost

Server Port: 2080

Scheme: hitp

Secure false

Header Elements

accept imagelgif, imagel-xhitmap, imagel



logout

@): this shows a menu bar in a new window:

D200 =0 @

Uzer data

Welcome to MASPECTRAS

User name:

Full name:

Email address:
Institute name:
Valid since:;
Valid until:

Last login date:
Last login realm:;
Password expin
Server Name:
Server Port:
Scheme:
Secure

Header E

accept

referer
accept-language
content-type
accept-encoding
user-agent

host
content-length
connection
cache-control
cookie

hartler

Juergen Hartler

Sample Generation
F Experiment

F Sample

F Sampleorigin

F Organizm

F Taggingprocess

Sample Processing

Mazs Spectrometry

MS-Analysis

Management

/3 http:/ /localhost:2080 SN [=| 73

|_ l_ l_ % J Local intranet

A

Pazsword | Preferences |

2004
2009

tnap, imadeljped, imagelpjped, applicati
nirmsword, *F
naspectrasfspsilaginjsp

m-urlencoded

e MSIE 6.0 WWindows MNT 5.1; W1, MET ¢

ement=YEEmMTICKBhLI=:4vdbuBwEXBcC
4281 62C439F45329BF4665680F

& : this removes the opened window.

1.1.3 The user (login) bar:

If you are not logged in:

°

login |

gives the possibility to log in

If you are logged in:

please login



@ logot | Userdata | Password | Preferences

gives the possibility to:

e Logout

[ ]

e Change your password
e Displays your user

[ ]

Sets the preferences for the display

1.1.3.1 Change Password:

Show detailed information about your user account

Juergen Hartler

- change your pa d
g USBMMArme:

Fullname:

old passward

new password

S e

| hartler

|Juergen Hartler

repeat new password I

Subrnit | Cancel |

You must enter your old password and repeat the new one two times. The password must
have at least 8 characters. One character must be a number and one character must be special

character (!”@="...).

1.1.3.2 Change Preferences:

| Window Setup:

|| small-window

| Menu Setting:

|| left-side-menu

| Tree Setting:

|| not displayed

| Owned by User:

In

Owned by Inst.:

i

KNIENIEN

|Eliuinfnrmatit:5 Group

Save



This allows customization of the menu structure for each user. Whenever the user logs in the
preferences are loaded and the menu display changes correspondingly.

Window-setup:

e small-window: same meaning like inl.1.1

e stretched-window: same meaning like == in 1.1.1

e fullscreen-window: same meaning like E inl.l.1

The “Menu Setting” and the “Tree Setting” have the same options. The option “left-side-
menu” is just possible for one of them, since otherwise to much space for the display of

information is lost:

left-side-window: the menu is displayed at the left side of the information screen
(default setting for the “Menu Setting”)
new-window-menu: the menu is displayed in a new window; for this option the
pop-ups for the Maspectras application must not be blocked.
not-displayed: the menu is displayed not at all.

The “Owned by” fields allow the specification of the default displayed ownership of entered
or edited data. This is just for the default view, while in every page the change of the
ownership is possible.

1.2 The information section:

/® Query & Edit Display Settings

1=

Spectrummill

(Partitianing )

Proteins per page:

[15] 25 50 100

107 Proteins found << Previous Page 2 of & Hext >= go to page |:| [111]

Hr. | Accessiondum | GeneMame SequCovMax

16 | gi[159237374 MP_199421 expressed protein [Arabidopsis thaliana). 11.214953271028037
17 | gil30862111 albumin [Felis catus] 11.130136986301 37
18 | gi|2108238 HFLK hotnolog [Treponerna pallidurn)] 10.809090909090908
158 | gil24213640 MP_T11121 hypothetical protein LADS40 [Leptospira interrogans seravar Lai str. S6601]. 10.204081632653061
20 | gil113578 ALBU_PIG Serum albumin precursar 10.082644R280949173
21 | gil3319897 albumin [Canis familiaris] 9.572649572649574
22 | gi|230289249 COGOE3T: Predicted phosphataselphasphohexomutase [Micrabulbifer degradans 2-40] 9.602262443438914
23 | gil 7836277 MP_495370 putative M-myristoylated protein (2H10) [Caenorhabditis elegans)]. 9.2105826315789473
24 | gilAERT188 AJ1334858_1 Canis familiaris mRMA for serum albumin. 9 210526314789473
25 | gil23098581 hypothetical protein OB1126 [Oceanobacillus iheyensis HTES31] 9.174311926605505
26 | gi|2492797 ALBL_MACMU Serum albumin precursar 8.833333333333334
27 | gift21887 GET26_SCHJA Glutathione S-transferase 26 kDa (GET 26) (SJ26 antigen) (GST class-mu) | 8.7155896330275229
28 | gi|a4402 AZE484 glutathione transferase (EC 2.6.1.18) - fluke (Schistosoma japonicum) fragment) B.BTSTHO086TAT9S
29 | gil22987378 COGATA1: Type ll secretory pathway, campaonent EscT [Burkholderia fungorum] 2.656716417910449
30 | gi|aYs718 glutathione S-transferase 8.1896551724137494

107 Proteins found

Proteing per page:

<< Previous Page 2 of & Hext ==

[15] 25 50 400
gotopage| |go




The general presentation of the data in MASPECTRAS looks like the figure above.
In the header section there are 2 links:

e Customizable queries

e Customizable display

The table with the data is always enclosed by the bars for the scrolling and almost every
column in the table is sortable.

If you come from another page, at the bottom of the page, there is a return button, which
brings you to page you have visited before.

1.2.1 Customizable queries:

Query X
|ru15|scr+1 Scare | |=~ | |2EI X
|Masci+2 Score | |:~ | |25 X
|ru15|sn:I+3 Scare | |:~ | |3EI X
[smit+1 Seore HIE RIE X
[Smitl+2 Seore HIE RIE X
[smin+3 Seore =l[- =2z anp X
Submit Query | Reset Query | Restore Default Save Queries

The query box enables the combination of as many queries as you like. The queries can be
added or removed. The operators “LIKE” and “NOT LIKE” need a preceding or trailing
asterisk

The button “Submit Query” submits the entered query and changes the view on the data
correspondingly.

“Reset Query” removes all entered queries and submits a query without any user-defined
filters.

Restore Default” restores the default set of queries and submits them.

“Save Queries” saves the actually entered set of queries as default to the database and submits
them. Unless you change the queries your data on that page will always be filtered with this
default set of queries.

1.2.2 Customizable display:

Availahle fields x
Required Information

¥ accessionMum I organism [ Sequence [T PredictedPi 7 M. of Proteins

¥ Genemame [T orumber T modifications W SequCoviax [ Cluster Mr.

[T Synonyms [T Description [T PredictedMass [ Score [T Search

Update | Display all | Display default Save Setlings



The information that will be displayed on the screen is customizable to the needs of the
end-user. The user can select the information by clicking on the checkboxes and update the
view on the data by pressing the button “Update”.

“Save Settings” allows the user to store his own display settings. Whenever the user enters the
same page his settings will be displayed by default.

1.2.3 Scrolling bar:

Proteins per page: [15] 25 50 100
107 Proteins found << Previous Page 2 of § Hext >= go to page qo

On the left the scrolling bar shows the number of elements that have been found (depending
on the query the user submitted). In the centre section the total number of pages with the
actual page is displayed, plus the two arrows to go to next or the previous page. In the centre
section the actual page is displayed and it is possible to switch to the previous and the next
page. On the right you can choose how many proteins you prefer to be shown on one page. At
the right side you can define the number of items per page and you jump to any page by
entering the page number and pushing the “go” button.

Hr. |[ID Upload Hame Category Added Date
1 2640 | casein_ML_M53 ¥ealibur 2005-06-249
2 | 2700 Tasklms22400-3601 | sequest 2005-07-06
3 2600 | testBighascot mascot 2005-06-21
4 | 2850 | newhascot mascot 2005-08-04
5 | 2001 | karlDB synthDatabase | 2005-06-07

f 2002 | kPEP_phospho_BSA | synthDatabase | 2005-06-07

7 2003 | myTestDB syhthDatabase | 2005-068-07
g | 2004 | SynthDB synthDatabase | 2005-06-07
4 2008 | SynthPep syhthDatabase | 2005-068-07
10 | 2006 | Spectrumill spectrummill 2005-06-07
11 | 2007 | Tasklms22400-3600 | sequest 2005-08-07
12 | 2009 | TaskZsynthDBAI sequest 2005-06-07
13 | 2010 | TaskZ2testkarlDB2 sequest 2005-06-07
14 | 2011 | TaskZCompToMasc | sequest 2005-06-07
15 | 2012 | MEDH mascot 2005-06-07

ol B By B B B B B B B B B B| Bs| B
RRERRRERR SRR SRR e

2 @ ®®®3®eRe®®e®N®eneee
XXX XXX XXX XXX XXX

The table view consists by default of the following parts:
e The header: if you hover your mouse over a column-name the colour changes to blue
and you can sort by this column



e The number in the first column indicates the hit number of the entry corresponding to
the order you sorted your data

e Links to data connected to the entries are normally located on entries in the list

e i : Indicates that you can edit your data here.

o T Indicates if there is some information downloadable

o X Indicates if you can delete this data entry here.

e @: Indicates that there is additional information available

e 81 : Indicates that you can share your data to other users of the system

When you click on the share icon you move to a page where you can select other users or
institutes and make the data available for them:

Sharing

You are about to share item: quantTestJune2006

Hame E-Mail
(Il __I'I'I_J Institute for Genornics and Bioinformatics Zlatkodrajanoskig@tugraz.at Eﬁl‘ }( Il
(Il ["_] Institue of Pathology, University of Graz karinwagner@klinikum-graz.at ﬁl‘ X =
- EJ Ingerm L1255 jerome@irgendwas fr ﬁr X]‘
| M visitors none g X
Il ﬂ Ludwig Bolzmann Institut gudrun.gann@klinikum-graz.at ﬁl‘ X Il
- EJ ARG Seibersdorf dietar. kopeckyiarcsmed.at ﬁr X =
(Il __I'I'I_J Sandoz GmbH thomas.specht@sandoz.com Eﬁl‘ Xl‘
r ["_] |.W.P. karl.Mechtler@imp.univie.ac.at ﬁl‘ XI_
- E] In=titute of Molecular Biotechnology Helmut.Schwabitugraz.at ﬁr X -
r __I'I'I_J Ingtitut fuer Chemie Christoph. lKratky@uni-araz.at Eﬁ?l‘ XI'
Il E] Ading Research guenterlepperdinger@oeaw.ac.at ﬁl‘ X Il
I~ M Information Design Department, FH JOANNEUM | infarmations-design@ft-ioanneum at | £ 7 2T
r __I'I'I_J Dept. Immunology, School of Pathology none Ecl?l_ X Il
™ | M Biocenter, Innskruck Zellbiologieg@i-med.ac.at S Xr
(Il E] Department for Specialized Gynaecology teresa wadnerig@akh-wien.ac.at ﬁr X]‘
| M oridis BioMed infog@aridis-hiamed.com S Xr

Hame Full Hame E-Mail

&1 hartler Juergen Hartler juergen.hartlergiugraz.at ﬁr XI_
™ | 81 testrmaspectras | TestMaspectras | Juergen hanlergiugraz.at S X
[T | &4 stocker Gernot Stocker gernot.stocker@tugraz. at Ecﬁ‘r X]‘

[T | & mechiler Karl Machtler Karl Mechtler@imp.univie.ac.at Ecl?l_ XI_



When you select a user or an institute the checkboxes at 5 and X are enabled and you can
additionally specify if the user has edit or delete rights on your data.

1.2.4 Select input Fields:

lonsource: myElectrospraylonsource

When you have an input field like the one above and your element of choice is not in the drop
down menu, you can push the blue button and enter your element. The button can lead either
to an input page of an element or to add dictionary elements. Dictionary elements are unified
text elements. The main purpose is to overcome words with different spellings (or different
level of detail in description) but the same meaning. For more detailed information about
Dictionaries, see chapter 2.5 “Dictionary”.

1.2.5 Multiple input Fields and other buttons:

Detection Agents: ?
Detection Agent: Idetectﬂxgent J el ':!j
Detection Agent: I j | 'i!)

Add detection agent

In MASPECTRAS there are very often multiple select or other input fields provided. With the
“Add ...” you can add additional input fields to your input mask, or with the X you can
remove them again. On important thing is, that when you add an object, or you any other

changes, the changes will be stored in the database when you press the M Button,

while when you press the < Button the data object will be deleted in the database,
immediately.
When you press the 4 Button you retrieve additional information about the selected object.

Rehydration solutions: ?

Rehydration solution: myGel=ubstance j e 'i!)
%l Details for gel matrix *
Component Concentration

componentone | 1.0

componentTwo | 2.0

In this example the solution consists of two components and they are shown below the select
field. When such a details field is open and you change the selected selection this field is
updated automatically. Such fields can be closed again with the ». When the % button is next
to an image the image is displayed at the bottom of the page.

The F provides you a help, so that it is clear what has to be entered at this input field. The
information appears at the top of the page.



>
Rehydration solution

x

The components, with concentrations (excluding the sample) of the rehydration solution which is loaded onto the gel, if

appropria

te.

1.3 The tree menu:

Evla - &z 6

51

51

=g
&-

Experiments

test ShowinTree

B testMode
i B anotherMade

nd

T sutomaticProfile

b B As_ICPL_t2ul_pro
B As ICPL_tzul_pro
B a5 ICPL_12u1_pror
b B S ICPL_1lzuZh_pr
b B AS_ICPL_tlzuzh_pr
B a5 ICPL_tlzuZh_pr
B A5_ICPL_tlzush_pr
B a5_ICPL_tlizushe _
B a5 ICPL_tlzuSh_pr
o B s ICPL_1lzuiih_g
b B A5 _ICPL_Tlizu10he
B as_ICPL_tlizulOhe
B A5_ICPL_Zlizuthe _
B 25 _ICPL_Zlizuthe
i P A5 _ICPL_Zlizuthe
oo as_ICPL_Slizuthe_
B a5 ICPL_Slizuihe_
P AS_ICPL_Slizuthe_
b B g ICPL_10lizuhe
B as_ICPL_10lizuthe

aanaaoananoaananannaanann

The tree menu has at the top the command line and below it is
showing a tree existing of experiments and sub-experiments
(see 3.1). Their child nodes can be samples (3.2) and the child
nodes of the samples can be massspecexperiments (see 6.1).

In the top menu you have 3 different selection possibilities:

: shows all of the elements of this search and does not affect
any of the other searches.

[2]: shows all of the elements of this search and from the other
elements just the ones which are in this search (just the
common ones of several searches are shown)

: elements marked with this icon are subtracted from the
rest of the selection.

For the selection of elements first the corresponding element
has to be selected from the command line at the top, and then
you have to click on the checkbox which you want to select.

To accept the selection click on g

In the next picture you can see a selection. You can see that for
the “&” and the “-* selection automatically queries has been
generated. For the “&” the operator is “=" and for the “-*“ the
operator is “<>”.



E v &[] |Gl b
= T € Experiments Proteln ® query F& Edit Display Settings
T o B anothersub Nede

2T testshoninTres Query | ®
7 B testhiode
I - B anotherblode [UPLOAD MamE =ll= =l |AS_ICPL_1zu1_pmﬁIesca x
Bof [UPLGAD MamE == =l [A51CPL 1201 _profilesca ann X
P BT AomaticProfile 5 -
: X T —— Submit Query | Reset Query | Restore Default Save Queries
]

B AS_ICPL_tzul_pro
ASICRL_T2ul pro 4 = AG |CPL_1zul_profilescan_B_cZdat  (Partitioning )
b B AS_ICPL_Tleuzh_pr
B )

| \CPL fluth e 2= AB_ICPL_Tzu1_profilescan_C_cz.dat  (Partitioning )
I 5P s IcPL it 3= ag_|CPL_12u1_profilescan_A_cZ (Pariitioning )
™ B a5 _IoPL_tizush_pr
I B s _IGPL_tliushe_
I 5 AICPL fleush_pe Proteins per page: 15 [25] 50 100
L P ag_ICPL_flautdhy 2 Proteins found Page 1 of 1 gotopage| |go
I B &5 ICPL_Tlizul0he
T i a5 _ICPL_llizu10he =
#sICPL iauths | NI+ | SQrch | Acchr Organism | GeneName %iSeqMax | Score | #Prots | #Peps |
Tk s crLauthe. | 1 |2 uil124408 Clpt 087 | 2002 1 1@
™ P a5 1CPL_ Hizuthe_ P z &
' T . 202 gil124318 Wiendt Kleisin Beta 474 | 2043 1 1@
T B a5 _IGPL_Stizuthe_
I b s _ICPL_Slizuthe_ Proteins per page: 15 [25] 50 100
F b s _ICPL_10liuthe 2 Proteins found Page10of1 go to page I:I go

Lo A5 ICPL_10lizuthe
P TP as ICPL 1Dlizuthe
T B notiorking Node

T L. P anothersub

Export Current View:

To Protein Yiew ==

To Peptide VWiew ==

When a folder is selected the same operator is applied to all massspecexperiments which are
in this folder. When a name of a folder or massspecexperiment is clicked for all of the

massspecexperiments associated the operation is applied.

Other menu items:

o

- unselects all of the selections
=
: refreshes the tree

: adds a new subexperiment to an experiment (will not work for samples or
msexperiments)

[

: moves one node to another one; the node to move must be marked with = and the
receiving node with



2. Management Section:

2.1 Database:

By clicking Management-> Database in the menu-bar you reach the general Database Section.
MASPECTRAS needs the original sequence databases to find out the corresponding protein
sequence.

Sample Generation
Mas= Spectrometry
MS-Analysis
Management

File Upload
b Status Information

w Databaze
Add Databaze
Find All Databases

F Software

F Dictionary

With the “Add Database” you can add a new database. The second possibility to upload a
database is the MultipleFiluploadApplet (see 2.2). This applet can upload databases bigger
than 2GB.

New Database

Databasename: | |

Yersion: | |

File I Browse... |

Y

De=scription:

Create |

When you select a file, the fields databasename and version are filled out automatically.
When you enter no version the version is set to 1 automatically.

With the “Find All Databases” you get an overview of all your databases.



Database

Nr. | Databasename
1 | testdh =]
2 nr Cri?
3 | wyeast Ccaf
4 | hovine Cﬁ
5 | karl =]
B | mouse E?f
7 | MSDE =]

When you have created a database or pushed the &l button you get to the detailed view of
your database:

Database yeast

| Rule to parse accession string from Fasta file: || (gitfd+ ) ‘
M) |
(MI(Pws]+)* ‘

| URL to the public database to retrieve information: ” http://eutils.nchi.nlm.nih.gow/entrez/eutils/efetch fcgi?db=proteinret

| Rule to parse description string from Fasta file:

Rule to parse organism from Fasta file:

| Parser for the URL information: || GBSeqiMLParser j
Nr. | Databasename | Version Status
1 | yeast 04090683290 | Inactive | =f
2 | yeast 04090683289 | Active o
3 | yeast 04090683291 | Active o
4 | yeast 1 Active =

_Retum |

At the top you can define your parsing rules for the accession string, the description string and
the organism string. Examples for parsing rules you will find in your installation package at
/doc/parsingRules. The meaning for the regexs you can find at
http://java.sun.com/j2se/1.5.0/docs/api/java/util/regex/Pattern.html. Accession rule and the
description rule are mandatory. In the next line you can specify the URL to the external
information fetch page (this URL has to end with ‘id=" or whatever your external information
page requires, so that the program can add the accession numbers it has to look for) and below
the parser for the information page. By default parsers are provided for IPI and GenBank



(although the GenBank parser delivers not so much information as the IPI parser since not so
much is available directly). If you want to enhance the existing parsers or write your own
parser please visit 2.2.1. .

With the green checkbox ¥ you can test your parsing rules and you get the output of the first
10 entries at the bottom of this page and the links to the external sources at the top:

External data link:hitp:/feutils.ncbi.nlm.nih. gowientrezieutils/efetch fogi? db=protein&retmode=xm|&id=gi| 19114688 gi| 1723488, qi[7490714,0i| 1213267
External html link: hitp:/swww.nchi.nim.nih.gow/entreziviewer fcgi?db=protein&id=gi| 19114688 gi| 1723488 qi|7490714 gi| 1213267,

Complete Entry:

>g1l]|19114688|ref|NF_593776.1| hypothetical homecbox domain protein [Schizosaccharomyces pombe]Dgi|l72
MREYSHPENGEQINDNINY SEKRPTMLPENLSLSNYDMDSFLGQFPSONMMQLPHSTYEQHLOGE QRNETHENYFEPEFD
EN¥VDWEQEKPEPDAPSFADNN SFDNVHN S SKLTHNESEV QPN IVESE SERPAN SEQNEVVEAT SVEKAKENVAHESGTPESG
GSTSAPKSKEQRLTADQLAYLLREFSEDTNPPPAIREKIGRELNIPERSVT INFQNRRAKSKLISRRQEEERQRILREQR
ELDSLNQKEVSQAFAHEVLET SPT S PYVGGIALNROYANT LLPEPTRETGNF YMESGPMQSSMEPCIAESDIPIRQSLSST
YYNS LS PNAVEV S S QR Y B S S Y S A T PN AM SV SN QA FDVESPPSSYATPLTGIRMPQPESDLYSYPREVSPSSGEYRMEG
HS¥PSSYKASGEVREPPNMAT GHMRTSSERPTSYDSEFYYFSCTLLVIGLWHRLRASPQDLMCFYSPRPEKLFAYLIQFQGIQR
YRIEYSFFVIESIHVFRVEEPLLNELSATASSRDEPAPNEYWLQMDIQLSVPEVFHMIT SEGQGHNCTDFTEGNQASEVLL
HSLMGRATSMFQMLDRVRRASPELGSVIRLQKGLNPHQFLDPOWANQLEPRQPDS SVFDHQGRNPPIQGLSHDTSSEYGNEK
SQF¥RLRSTSTPARQDLAQHLLPPKTNTEGLMHAQSV S PIT QAME SANVLEGSSTRLNSYEPSVES SAYPHHNLALNLDNT
QFGELGTSMNISYPLSAPSDVESLPRASHNSPSREVMHENT QGINTEIRDMALQFPNSQTGELT PNSWSMNTHVSVEETT QN
REFGGIGSSSISTTMNAPSQQLSOVEFGDVSLATENSVEPSYGFEVPSEE SVYAQRRTHS SVSAGVAPRLFIQTPSIPLAS
SAGQDSNLIEKSSSGGEVYASQPGASGYLSHDQSGSPFEDVY SPSAGIDFQELRGQQFSPDMY

Fule accession rule: gi|19114688,gi|1723488,g1|7490714,91|1213267,
Rule description rule: hypothetical homecbox domain protein [Schizosaccharomyces pombe],Hypothetical |
Rule organism rule:!: Schizosaccharomyces pombe,null,null, Schizosaccharomyces pombe,

Complete Entry:

>gi| 496693 |emk |CARASE6020.1| B-127 protein [Saccharomyces cerevisiae]
MPFSFLAQFFPPCEISSTHSLGVNSPGRGSHGNLNVEFWYELSISGLIEEDIVVDSEGEVVISLLLWLVEVGDLILVLFPV
AFVPGFATVVPIPLELENVFLGDINEFVVDVGLDSSDVLSSIVFIPGL

Rule accession rule: gi|496633
Rule description rule: B-127 protein [Saccharomyces cerevisiae]
Fule organism rule: Saccharomyces cerevisiae

Complete Entry:

>gl| 6323056 |ref |[NP_013128.1| AICRR transformylase/IMP cyclohydrolase; Adelép [Saccharomyces cerevisia
MEEYTHIAIL VY DETGLL D LAY GLVENNVRILAS GCTANMVREAGFEVDDVS S ITHAPEMLGGRVET LHPAVHAGILAR

HLEGDEEDLEEQHI DKVDEFVVCHNLYPFRETVARIGVIVQEAVEEIDIGGVI LLRARARNHSRVT ILSDENDYSIFLQDLS
EDGEISQDLRNRFALEAFEHTADYDAAT SDFFREQYSEGHAQLPLRYGCHPHQREPAQAYITQQEELPFEVLCGTPGYINL
LDALNSWPLVEELSASLNLPALASFEHVSPAGRAVGLPLESDVERQVYFVNDMEDLSPLACAYARARGADRMSSFGDFIAL
SMIVDVATAKIISKEVSDCVIAPGYEPEALNILSKKENGHYCILQIDENYVEPGOMESREVEGVT LQQKRNDATINQSTFK
EIVSENEALTEQAVIDLTVATLVLEYT QSHSVCYRRKNGHVVGLEAGQOSRIHCTRLAGDET DNWWLR QHPEVLNMEWAK G
IXRADESNAIDLEVIGQRIEGPEEVDYE SKFEEVPE PFTHEERLEWLSE LN VS LS SDAFFPFPDNVYRAVQSGVEFITR
PSGSVMDEVVFQALDSFDIVYVENPIRLFHH

Rule accession_rule: gi|6323056,g9i|1709914,9i|7433574,91|1480728,9i]12204263,
Rule description rule: RAICAR transformylase/IMP cyclohydrolase; Adelép [Saccharomyces cerevisiae],Bif
Rule organism rule:!: Saccharomyces cerevisiae,null,null,null,Saccharomyces cerevisiae,

First you get the complete database entry. At “Rule accession_rule:” you get your returned
accession strings. If there are multiple ones for one entry they are always separated by “,”. It
is mandatory that the accession string that you see here is the same like in your result files
because this one is used for the indexing. At “Rule description_rule” you get the description
of your protein. At “Rule organism_rule:” you get the result of your organism rule. If there is
a “null” within the string, than this rule didn’t return anything (happens sometimes, when
there are no organisms declared). The first line (this will be just there URL and the parser is
chosen) is the external link how the data is returned for the parser, the second line is the link
which will be put on the accession number in the protein overview (see 7.1)

If you are content with your result push the lie_| button to index your database.
The database can have the following stati:

A8 . The database is active and can be used for file parsing.



: This database is indexing. (This page is not refreshed automatically at the moment)

act , : : :
"% . The database has not been indexed or something at the indexing has gone wrong

It is not mandatory to keep all the versions of your databases. Once a search result file has
been parsed into MASPECTRAS it stays conserved and does not need the old database again.
The database section should be reserved to an administrator of MASPECTRAS, because
when the definition string is changed in a running instance, you have to be aware that there
may be pending data uploads which need information with the old settings. Once the data is
uploaded into MASPECTRAS there is no need to keep the old database, the whole sequence
is stored within MASPECTRAS.

2.2.1 Enhanced or self-written parsers plug-in:

MASPECTRAS features a plug-in mechanism to extend the external DB-information fetch. A
self-written parser (in a JAR-file) has just to be put in the
$JBOSS_HOMES$/server/maspectras/sequenceParsers folder to be detected at the next restart
of MASPECTRAS. The current implementation provides parsers for IPI and GenBank (here
not all of the information available) and therefore there are the IPIParser.jar and the
GBSeqXMLParser.jar. The IPIParser can be regarded as show-case of how to implement a
self-written parser and therefore it is provided including the source code (IPIParser.java) (in
the GBSeqXMLParser the source code is provided as well but rather for self-written
enhancements).

The JAR-file must contain the parser class (in binary format), all classes which are required
for your parser and the following entry in the META-INF/MANIFEST.MF:

Parser-Class: at.tugraz.genome.maspectras.parser.sequencelnformation.IPIParser.
This is the fully qualified name of your parser class, so that MASPECTRAS knows which
Class to instantiate for the parsing. The self-written parsing class has to implement
at.tugraz.genome.maspectras.parser.interfaces.SequencelnformationParser interface to be
accepted, which can be found in the maspectras.jar. The parsers have to return a
Vector<SequenceResultVO>, which contain the identifier of the external plus a description
(not mandatory can be ‘null’ as well). The current implementation allows the fetch of
information about:
e Entrez Gene
Ensembl;
Ensembl Havanna
Gen3D
GO
NCBI Taxonomy
InterPro
PathoSign
Pfam
PROSITE
RefSeq
SMART
UniProt-SwissProt
UniProt-TrEMBL
Vega
PubMed
iHOP
KEGG




e Gene symbol
e Synonym

If your required web-page does not deliver some of the required information, just return ‘new
Vector<SequenceResultVO>;’ or null. If further information entries are desired please contact
the developers at maspectras@genome.tugraz.at . It is important that the parser can handle
the fetch of several entries at once identified by an accession number, since MASPECTRAS
fetches always a bundle of 50 entries, since one by one would take too much time. For a
detailed documentation of a parser please take a look at the IPIParser.java.
The external fetch strategy itself works like the following:

e HTTP connection to the external data resource you specified in 2.1

e Parsing with a standard parser or your self-written parser

e If a Uniprot-Swissprot entry exists the system makes a connection to Uniprot as well

to receive further information (e.g. Pubmed identifiers)

e Parsing of Uniprot files by existing MASPECTRAS parsers
Therefore it is possible that further information is fetched via Uniprot if your parser returns
Uniprot identifiers, which is not in the original data file.

2.2 File Upload:

Sample Generation
Mas=s Spectrometry
MS-Analy=sis
Management

File Upload
p Status Information
F Database
p Software

F Dictionary

By clicking Management->FileUpload in the menu-bar you reach the general Upload Section,
where all your already uploaded files are listed:



File Upload /® Query @ Edit Display Settings

Files per page: 15 [25] 50 400

2 Files found Page 1 of 1 gotopage [ |go
Nr. |ID | Upload Name Category | Added Date

1 281 | ICPL_Protmix_1lizuthe_A_c1 rawdata 2008-02-13 Eﬁ 'ﬁ el )(

21282 | ICPL_Protmix_1lizuthe_A_c1_ms2 | mascot 2008-02-13 Eﬁ 'ﬁ al )(

Files per page: 15 [25] 50 100
2 Files found Page 1 of 1 go to page |:| go

Mew file upload | Mew rmultiple file upload |

With “New file upload” you come to the upload page:

New File Upload

e ] |

File I Browse... |
r
| File Type | j

Raw-File

MS-Paramsters

SpectrumMill

SpectrumMill Before Version A.03.02
SM Config

SM Custom Conﬁi

Upload | 1Sequest
XTandem
Omssa
Omssa Modification File
CeMM-Internal
CeMM Definition File
Gel1D Raw Image
Gel1D Warped Image
Gel1D Annotated Image
Gel1D Warping Map
Gel2D Raw Image
Gel2D Warped Image
Gel2D Annotated Image
Gel2D Warping Map
LC-Colurnn Parameters

Comment

The important thing is that you have to add your file to the corresponding category.

The Sequest-Files and SpectrumMill-Files must be uploaded in a *.zip directory. Spectrum
Mill is differentiated in “Spectrum Mill” (new version) and “Spectrum Mill Before Version
A.03.02” (old version). For the new version a SM Config File (your smconfig.xml file) is
necessary. The SM Custom Config (your smconfig.custom.xml) is not mandatory, but needed
when you searched with modifications and elements which you created by yourself. For
OMSSA searches the Omssa Modification File (mods.xml) is needed. As “Raw-File”
mzXML, mzData and XCalibur Version 1.3 RAW are accepted. After the raw file is uploaded
an automatic conversion in a more convenient format for the calculation is started (you can
see the progress in the upload status page see 2.3). automatically. If this is not desired, there is
the option to work directly on one of the formats, but then the real 3D view does not work,
just the quasi-3D view (see 7.7). If you want to turn off this feature contact the administrator



of your system. In the file

$DATAROOTDIRECTORY $/analyses/partitioning/cluster.properties there is an attribute
translateChromatograms=true. Set this attribute to translateChromatograms=false. The “Local
File” check box is just applicable if the file is on the same system (or mounted on the system)
where MASPECTRAS is located. Here no upload is made just a link to the file is stored.
Through this file duplication can be avoided and disk space saved.

When you click “New multiple file upload” you come to the multiple file upload applet:

Multiple File Upload BAaddfiies x|
(50T | st database T 2EE
4By Add Files | 8y Remave |
karl_04090653392.fa
| File name | Directory | Sies gk |
| 0 File(s3, 0 Kb ta upload left
[~ Compress Files ™ Lacal File Link. FASTA-Database ﬂ
Upload Cancel |
File name: |kar|704090683392.fa Add Files
You need aJava Plugin Version 1.5.x. Files of type: - PR
Using compression is only recommended for remote uploading data that can be well com i IA" Files _I S
(eg. plain text files, xml files and not images or already compressed files).

Cancel

With the “Add Files” a new window opens where you can choose your files and they are
displayed in the list below. In the list you can select the files and with “Remove” you can
remove them from the list. The “Compress File” option can be used to reduce the transfer
over the network but it takes some time to compress and decompress the file again. This
option should not be used for already zipped files. Then there is a select box with the
categories. There are the same ones like in the normal “New file upload”, plus the category
“FASTA-Database”. With this option you can upload databases bigger than 2GB into the
system. The database is not displayed in the normal “FileUpload” list but moves directly to
the databases (see 2.1). The “Upload” button starts the upload of the selected files. When the
upload was successfully finished a green check icon appears in front of the name. When there
was an error a red “cross-out” icon appears.

2.3 Upload Status:

By clicking Management->Status Information->Upload Status in the menu-bar you reach the
general Upload Status Section.

Sample Generation
Managemennt
File Upload

w Status Information
Upload Status



This page gives information about the progress of tasks, which are processed asynchronously
because of their time consume.

Upload Status

[} Upload Name Status Step Progress in %
[~ | 11850 | testkarll LOADING FINISHED e 100 %
[~ 11851 | testkar22 LOADING FINISHED e 100 %
™ 11852 | testkar23 LOADING FINISHED e 100 %
[ | 11951 | FOO1244 LOADIMG FINISHED e 100 %
[ | 12050 | FOO1276 LOADING FINISHED e 100 %
[~ 113000 | Taskims22400-3600 LOADING FINISHED e 100 %
[~ 13300 | Spectrurmidill LOADING FINISHED e 100 %
™ 113301 | MascotCompSpectridill LOADING FINISHED e 100 %
[~ | 13400 | BSA_500fmolHE-1000fmolDE | LOADING FINISHED e 100 %
[T | 13550 | CompToSequest LOADING FINISHED e 100 %
[~ | 14250 | TaskZsynthDBAI LOADING FINISHED e 100 %
[~ | 14350 | Task2testkarDB2 LOADING FINISHED e 100 %
[T | 14450 | newhascot LOADIMNG FINISHED e 100%
[ | 14750 | MSDB LOADIMNG FINISHED e 100 %
[~ | 14850 | Task2CompToMase LOADING FINISHED e 100 %

| Update Interval [m:ss] ||D:30 | Set timer |
Select All I Select Finished | Select Failures | Inwvert Selection

Delete Selected |

2.4 Software:

By clicking Management->Software in the menu-bar you reach the general Software Section.

Sample Generation
Mas=s Spectrometny
MS-Analysis
Management

File Upload
p Status Information
} Database

w Software
Add Sottware
Find Al Softwares

b Dictionary

The general software section is used to document all the software used in MASPECTRAS.
Here you can get an overview about the software and edit them. When the software is needed
in a select box in another table you can add new software from there directly (e.g. see chapter
5.5 “Controlsoftware”).



With “Add Software” you can add new software.

New Software

Name: j @
Version:

DateOfRelease: W
roe: 1@
Add Upgrade

| Owned by User: | [~
|0Wnedblf Inst.: | | ||nserm L2585 j

e

With the link “Add Upgrade” you can enter software upgrades.

With “Find All Softwares” you get an overview of all your general software.

Software ® Query % Edit Display Settings

Softwares per page: 15 [25] 50 100

1 Softwares found | Pagedofi | go to page |:| go
Mr. | Name Yersion | Role
1 | ¥Calibur | 2.0 massSpectrometrySoftware Eﬁ ﬂ }(

Softwares per page: 15 [2%] 50 100
1 Softwares found | Pagelof1 | go to page |:| go

2.5 Dictionary:

By clicking Management->Dictionary in the menu-bar you reach the general dictionary
section.



Sample Generation
Mazs Spectrometry
MS-Analysis
Management

File Upload
p Status Information
F Database
F Software

w Dictionary
Add Dictionary
Find All Dictionarys

The dictionary section stores commonly used values for certain input fields. Here are you can
add, edit and change dictionary values from all domains, while when you are in another table
you can only select an existing dictionary field and add values for this certain domain.

With the “Add Dictionary” you can add a new dictionary entry.

New MaspectrasDictionary

Domain:

Value:

Description:

Create |

By clicking the “Find All Dictionarys” you will get an overview of all your dictionaries.



Mas pect rasDiction ary ® Query § EditDisplay Settings

MaspectrasDictionarys per page: 15 [25] 50 100

43 MaspectrasDictionarys found Page 1 of 2 Hext ~> go to page |:| go
Hr. | Domain Value Description

1 | MsResolutionlimit 10% valley & | X
2 | MsResolutionlimit FiMHM =D
3 | esiSypplType static ﬁﬁ‘ X
4 | esiSypplType fed & X
A | esiSolventFlowratelinits micralitres/min ﬁ x
A | esiSolventFlowratelinits micralitres/min ﬁ x
7 | maldiPlateComposition stainless steel Ef x
8 | maldiPlateComposition coated glass Ef x
9 | maldiMatrixcomposition alpha-cyano-4-hydroxicinnamic acid E‘ff )(
10 | malidPsdType FSD ﬁﬁ‘ X
11 | malidPsdType LD =P
12 | TofReflectronState an =P
13 | TofReflectronState aff & X
14 | TofReflectronState naonge ﬁ x

2.6 Equipment:

By clicking Management->Equipment in the menu-bar you reach the general equipment
section.

Sample Generation
Sample Processing
Mas= Spectrometry
MS-Analysis
Management

File Upload
b Status Information
p Database
p Software
w Equipment

Add Equipment

Find Al Equipments

F Dictionary

The equipment section stores all kinds of equipment needed (for 1D Gels, 2D Gels, ...).
With the “Add Equipment” you can add a new equipment entry.



New Equipment

ModelHame:
EquipmentType: I gelTank j @

ModelManufacturer: I j @

ModelHumber:

Create |

Because of the fact that the equipment section is general, it is necessary to enter the type of
the equipment. Then it is easier to find the wanted one.
By clicking the “Find All Equipments” you will get an overview of all your dictionaries.

Eq u i p me nt ® guery & Edit Display Settings

Equipments per page: 15 [25] 50 100
& Equipments found | Pagedof1 | gotopage| |go

Nr. | ModelMame

1 | anotherEquipment

2 | laserScannerEquipment

3 | testadding

4 | testinterAdding

5 | testOneMoreAdding

B B B B B By
Beeeee
X[ X[ X X XX

6 | bufferEquipment

Equipments per page: 15 [25] 50 100
& Equipments found | Page1of1 | gotopage| |go

3. Sample Description:

3.1 Experiment:

By clicking Sample Generation->Experiment you reach the experiment section.



Sample Generation

w Experiment
Add Experiment
Find All Experiments

F Sample

} Sampleorigin

F Organism

} Taggingprocess
Mass Spectrometry
MS-Analy=is

Management

With the “Add Experiment” you can add new experiments.

New Experiment

Hypothesis:

MethodCitations:

ResultCitations:

Title:

Description:

| Show in tree: || yes j

| Owned by User: | r
|owned by Inst.: | ¥ |E3ioinﬁ:+rmatics Group j

Create

With the “Show in tree” option you can specify if this experiment should be shown in the tree.

With the “Find All Experiments” you get an overview of all your experiments.



Ex pe riment ® Query §& Edit Display Settings

Experiments per page: 15 [25] 50 100
1 Experiments found Page 1 of 1 go to page |:| go

Hr. | Title

1 | testexp |25 83 | XK

Experiments per page: 15 [25] 50 100
1 Experiments found Page 1 of 1 gotopage| |oo

3.2 Sample:

There are 2 ways to generate your sample:

3.2.1 Sample directly:

Here it works in the same way like in the experiment.
By clicking Sample Generation->Sample you reach the sample section.

Sample Generation
F Experiment

w Sample
Add Sample
Find Al zamples

F Sampleorigin

F Organism

} Taggingprocess
Mas=s Spectrometry
MS-Analy=sis

Management

With the “Add Sample” you can add a new sample:



New Sample

Sampleld:

SampleDate: B

Title:

ProteinAmount:

Description:

Sampleorigins

(KN
@
X

Sampleorigin:
Add Sampleorigin

|0m1edh3ru=er: ||_

|0wnedh1.r Inst.: | v |Eiiuinfnrmatic5 Group j

=S

With the link on “Add Sampleorigin” you can add additional origins to the sample. If your
desired sample origin is not in the list you can add it directly with the blue button on the right
side of the select field. Read more about sample origins in chapter 3.3 “Sampleorgin”.

With a click on the button “Find All Samples” you get an overview of all your samples:



/% Query & Edit Display Settings

Samples per page: 15 [25] 50 100

4 Samples found | Pagedofi1 | go to page |:| go
Hr. | Sampleld SampleDate | Title Description | ProteinAmount
1| forLex 2005-07-05 | forLexi cF 88| X
2 | newMascot 2005-08-04 | newMascot 58X
1 | testQuanti 2005-06-28 | testGuanti &F 88X
ch |88 | X

4 | tegtProphetScore | 2005-08-04 | testProphetScore

Samples per page: 15 [25] 50 100
4 Samples found | Pageiof1 | gotopage| |go

3.2.2 Sample over experiment:

Ex pe ri me nt ® Query @ FEdit Display Settings

Experiments per page: 15 [25] 50 100
1 Experiments found | Page1of1 | gotopage| |go

Nr. | Hypothesis | Title Submitter
1 | testExp testExp | Juergen Hartler ﬁ a X

Experiments per page: 15 [25] 50 100
1 Experiments found | Page1of1 | gotopage| |go

When you click on the title of your experiment where you are interested in then you get an
overview of all your samples which has been added to this experiment.



® Query §& Edit Display Settings

Experimeants

Nr. | Title
1 testhode af | X
2 | anotherfode ﬁ )(
3 nd =P
4 | notWarkinghode ﬂ‘ }(
A | anatherSub ﬂh )(
Samples per page: 1% [25] 50
1 Samples found | Pagedof1 | go to page
Hr. | Sampleld SampleDate | Title Description | Proteinimount
1 AutomaticFT | 2007-07-16 | AutomaticFT ERE RS
Samples per page: 15 [25] 50
1 Samples found Page1of1 | go to page
Add Sub Experiment Create Sarmple for Expetiment Add Sarmples ‘Compare Results |

Return |

With the “Add Sub Experiment” you can create a sub-experiment.

When you push the “Create Sample for Experiment” button you can generate a new sample
and it will be added directly to the experiment.



New Sample

Sampleld:

SampleDate: B

Title:

ProteinAmount:

Description:

Sampleorigins

sampleorigin: || -] @ %

Add Sampleorigin

|0m1edb3ru=er: ||_

|0wnedb1.r Inst.: | v |Eiiuinfnrmatic5 Group j

=S

When you use the “Add Samples” button you can add or remove existing samples to or from
your experiment.

2 Query ¥ Edit Display Settings

Samples per page: 15 [25] 50 100 Samples per page: 15 [25] 50 100
2 Samples found | Pagedof1 | gotopage| |go 2 Samples found | Pagedof1 | gotopage[ |go

Sampleld Sampleld
[~ | forlexi

[T | testQuant

[T | testProphetScore [T | newmMascot

Samples per page: 15 [25] 50 100 Samples per page: 15 [25] 50 100
2 Samples found | Pagetof1 | gotopage[ |go 2 Samples found | Pagelof1 | gotopage[ |go

Return |

On the left side the addable samples are listed and on the right side the already added samples
are listed. The left side is completely queryable. When you want to add samples you simply
check the desired checkboxes of the samples on the left side and push the “>>" button. When



you want to remove samples you simply check the desired checkboxes of the samples on the
right side and push the “<<” button.
The meaning of the “Compare Results” button will be explained in the Analysis section (4).

3.3 Sampleorigin:

By clicking Sample Generation->Sampleorgin you reach the sample origin section.

Sample Generation

} Experiment

F Sample

w Sampleorigin
Add Sampleorigin
Find &l Samplecrigins

F Organizm

} Taggingprocess
Mass Spectrometry
MS-Analysis

Management

With the “Add Samplorigin” you can add new sample origins.



New Sampleorigin

Hame:
| B0
P )
samplecondition: | | @
ConditionDegree: || -|@®
Environment: || - @®
TissueType: | -l @
CellType: | @
CeliCyclePhase: | | @
CellComponent: | j @
Technique: | - @®
MetabolicLabel: || @
=
Description:
~

|Dwnedh3rl.lser: | r
|Dwnedh3rmst.: | ¥ |Biuinﬁ:+rmatics Group j

=S

If your desired organism or tagging process is not in the list you can add it directly with the
blue button on the right side of the select field. Read more about organisms in chapter 3.4
“Organism” and about tagging processes in chapter 3.5 “Taggingprocess”.

With a click on the button “Find All Sampleorigins” you get an overview of all your sample
origins:



Sam p I e ri g i n ® Query §& Edit Display Settings

Sampleoriging per page: 15 [25] 50 100
1 Samplecriging found | Page1of1 gotopage| |go

Hr. | Name Organism

1 | aGoodOrigin | Hurman & 83X

Sampleorigins per page: 15 [25] 50 100
1 Sampleorigins found | Page1of1 go to page |:| go

3.4 Organism:

By clicking Sample Generation->Organism you reach organism section.

Sample Generation
F Experiment
F Sample
F Sampleorigin
w Qrganism
Acdd] Organism
Find All Organisms

¢ Taggingprocess
Mas=s Spectrometry
MS-Analy=sis

Management

With the “Add Organism” you can add new organisms.



New Organism

SpeciesName:

Strainldentifier:

RelevantGenotype:

| Owned by User: | | |
| Owned by Inst.: | I~ |E!iuinfurmatic5 Group _ﬂ

Create

With a click on the button “Find All Organisms” you get an overview of all your organisms:

o rg an i <sm ® Query & Edit Display Settings

Organisms per page: 15 [25] 50 100
1 Organisms found | Pagelof1 | go to page |:| go

Hr. | Speciesiame

1| Hurnan =R A

Organisms per page: 15 [25] 50 100
1 Organisms found | Pageiofi1 | go to page I:l go

3.5 Taggingprocess:

By clicking Sample Generation->Taggingprocess you reach tagging process section.



Sample Generation
b Experiment

b Sample

¢ Sampleorigin

} Organism

w Taggingprocess

Add Taggingprocess
Find Al Taggingprocesses

Mass Spectrometry
MS-Analysis

Management

With the “Add Taggingprocess” you can add new tagging process.

New Taggingprocess

Hame:

Ly=sisBuffer: I j @
TagType: | S0

TagPurity:

ProteinConcentration:

TagConcentration:

FinalVolume:

IncubationTime:

| Owned by User: In
| Owned by Inst.: | I |Bioinﬁ:rrmatics Group j
Create

With a click on the button “Find All Taggingprocesses* you get an overview of all your
tagging processes:



Tag g i n g p rocess ® Query & FEdit Display Settings

Taggingprocesss per page: 1% [2%] 50 100
1 Taggingprocesss found | Pagetof1 | go to page |:| go

Hr. | Name

1 | ryTaggingProcass | £ 83 | X

Taggingprocesss per page: 15 [25] 50 4100
1 Taggingprocesss found | Pagetof1 | go to page |:| go

4. Sample Preprocessing:

Here, information about the preparation steps of a sample can be entered.
First, you have to click on “Sample Generation->Sample->Find All Samples” and you get an
overview of all your samples:

/% Query §& Edit Display Settings

Samples per page: 15 [25] 50 100

4 Samples found Page 1 of 1 go to page |:|gn
Nr. | Sampleld SampleDate | Title Description | ProteinAmount

1| forLexi 2005-07-05 | forLex ch 8 X

2 | newhlMascot 2005-08-04 | newMascot Eﬁ a1 x

3 | testouant 2005-06-29 | testQuanti =TRE e

4 | testProphetScore | 2005-08-04 | testProphetScare c9 |88 | X

Samples per page: 15 [25] 50 100
4 Samples found Page 1 of 1 go to page |:| go

When you want to get more information on a sample, you click on the name for “sampleld” in
the corresponding column to you reach the sample processing part. When you have a sample
with no entries you will get the following page:



Tree View Sample testSample @ Edit Display Settings

refresh tree

Sample

Gel 1D
add Gel 1D

Gel 2D
add Gel 2D

Lc Columns

add Lc Calumn

Otheranalyte Processing Steps

add Other Analyte Processing Step

Chemical Treatment Processing Steps

add Chemical Treatment Frocessing Step

Massspec Experiments
addirernove Massspec experiments

On the left side there should be a tree but now only the root element is there (the sample).
If you have entered values the page could look like the following:

Sam ple § Edit Display
quantificationApril2006 —
refrash tree
£y Sample
@ MS Experiment Gel 1D
E"‘g‘;e;ﬁt add Gel 1D
r {3] MS Experiment Gel 2D

423 %r;z;”r::n't Nr. | Description | Percenticrylamide | StainDetails | PiStart | PiEnd | MassStart | MassEnd
“[@] Treated Analyte 1 | acelzd =P
F{g Snot
w(g Seot add Gel 2D
B Spot
[]D Sth Lc Columns
E]G Sth add Le Column
w{ Heot Otheranalyte Processing Steps
= Spot add Other Analyte Processing Step
F{g Spat
F{q Spot Chemical Treatment Processing Steps

add Chemical Treatment Processing Step

Massspec Experiments

Hame | Raw File | GenerationDate

testExp

addirernove Massspec experiments

The page splits into two parts, the tree view (see chapter 4.1 “Tree View”) and the
information view where you can display and edit your data. You can arbitrarily manage your



preparation steps here. E.g. you have a sample. With one half you ran it over an LC-Column,
and got 3 Fractions which are interesting. The other half was first digested with trypsin and
you got one treated analyte. With this one you made a 2D-Gel where you got a 2 interesting
spots. Then the tree would look like the following:

Tree View Sample testSample & Edit Display Settings
refresh tree
=y Sample
&y Le Colurnn Gel 1D
[ Fraction add Gel 1D
[ Fraction
~[@] Fraction LiTi
E1Ey Chemical Treatment Adzel 2l
Ea Treated Analyte Lc Columns
B&y Gel2D
@ E oot Mr. |Title |Descriptiun InternalLength | InternalDiameter | FlowRate | Injectionfolum
po
@ Spot 1 !mvColumnExpenment |

add Le Column

Otheranalyte Processing Steps

add Other Analyte Pracessing Step

Chemical Treatment Processing Steps

Nr. | Digestion Derivatisations
1 | trypsinDigestion Cﬁ X

add Chemical Treatment Processing Step

Massspec Experiments
addiremove Massspec expetiments

That means you can illustrate any splitting and any consecutive treatment. Regardless of the
separation method you choose the organization is always the same. First you have a page
where you can enter information about the separation method itself. After you have entered it
once you can add with the edit option an arbitrary number of analytes. When you click on one
of these analytes you will get again to a page where you can choose again between different
analyte processing methods:



Treated Analyte myTreatedSample % EditDisplay Settings

refresh tree
By Sample
=iy Le Calumn Gel 1D
~ [@] Fraction add Gel 1D
@ Fraction
~[g] Fraction oekeh .
E‘a Chemical Treatment Nr. | Description | PercentAcrdamide | StainDetails | PiStart | PiEnd | MassStart | MassEnd
E-a Treated Analyte 1 | myGel2dExperiment | ﬁ X
E-a Gel 2D
@ Spot add Gel 2D
@ Spot
Lt Columns

add Lc Column

Otheranahyte Processing Steps
add Other Analvte Processing Step

Chemical Treatment Processing Steps

add Chemical Treatment Processing Step

Massspec Experiments

addiremaove Massspec experiments

There are 5 different processing methods. A GellD leads to bands (for detailed information
see chapter 4.2 GellD), a Gel2D leads to spots (for detailed information see chapter 4.3
Gel2D), a LC-Column leads to Fractions (for detailed information see chapter 4.4 LC-
Column), a Chemical Treatment leads to Treated Analytes (for detailed information see
chapter 4.5 Chemical Treatment), and Other Analyte Processing Steps (for detailed
information see chapter 4.6 Other Analyte Processing Step) leads to Other Analytes. For all of
the analytes Massspec experiments can be added (for detailed information how to add them
see chapter 4.7 “Adding of Massspec experiments”). How you generate a Massspec
Experiment see chapter 6.1 “Mass spectrometry experiment”.

4.1 Tree view:

In the tree view the cross linking of the data is displayed graphically. In the tree the types of
the analyte processing steps and the analytes are displayed. If you want to know the name of
an element, you have to move your mouse over the element and a tool tip with the name will
appear.



Tree View

refresh tree

=y Sample
E‘ﬁ Lc Calurmn

@ FralmyColumnExperiment |
@ Fraction

@ Fraction

E"ﬁ Chermical Treatment
=<y Treated Analyte

moy Gel 2D

@ Spot
~[8] Spoat

When you click on an element, information about this element will be displayed.
When you enter information on the right side the tree won’t be updated automatically.
Press “refresh tree” to update it.

4.2 GellD:

Sample testSample ¥ Edit Display Settings

Gel 1D
add Gel 1D

Gel 2D
add Gel 20

Lc Columns

add Lo Column

Otheranahte Processing Steps

add Other Analyte Processing Step

Chemical Treatment Processing Steps

add Chemical Treatment Processing Step

Massspec Experiments

addfiremove Massspec experiments



When you are on the page of a sample or an analyte you can add a GellD with the link “add
Gel 1D”. When you have added a GellD you will be redirected to the previous page
displaying the added GellD.

Gel 1D

Mr. | Description | PercentAcndamide | StainDetails | MassStart | MassEnd

1 | myGellD &5 | X

add Gel 1D

When you click on the description name or on the edit button you can edit it again.

Ed it Gel 1 D @ Edit Display Settings
‘ Gelldid: ” testFull ‘
Gel Buffer Band Detection Image Acquis. !_ Image |
| Aqucisition Equipments: | ?
| Aqucisition Equipment: | |IaserScannerEquipment j | @ X
| Aqucisition Equipment: | [anctherEquipment = % @ X
Add equipment
| Acquisition Softwares: | ?
| Acquisition Software: | |imageAcquSoﬂware 1.02 Soﬂwareupgralj & | @ x’
| Acquisition Software: | |anulher80ﬂwareType 20 == @ x
Add image acquisition
softwares
| EquipmentCalibration: | |manua| j ?
EquipmentSpecificParams =
EquipmentSpecificParams: ?
ImageicguisitionProcess =
ImageAcquisitionProcess: ?
-
| Acquisition Component: | |Stacking gel 6.0 y:7.0 8.0 j ?
Update
add Band
Nr. | Title Area | Intensity | LocalBackground | Annotation | Normalisation Description
1 |test 10 |20 3.0 4 aNormalizationMethod | dasd a | X
2 | testBoundaryChain = .

For the “Acquisition Component” you can select the whole selected “Gelmatrix” named with
“Main” (you will find this select field, when you click on the “Gel” tab) or one of the
components of the “Gelmatrix”. The references to the files (mostly images) which you can
select in the “Image” tab, must be uploaded with the following upload types: GellD Raw
Image for the Raw Image; GellD Warped Image for the Warped Image; GellD Warping Map
for the Warping Map; GellD Annotated Image for the Annotated Image. All of the images
can be displayed on this page as well.



Additionally to the create page link the “add Band” link for adding bands and a list with
added bands will be displayed (here the edit page is shown).

Edit Band

Title: testBoundaryChain

"

Area:

"

Intensity:

"

LocalBackground:

"

Annotation:

"

AnnotationSource:

"

VYolume:

Hormalisation: I j @

HormalisedVolume: | |

"

"

"

LaneHumber:

"

ApparentMass:

"

Description:

| LocalisationtemType: | IElDundarj,f Chain j

Boundarypoints: 2

E 10 E 20 ?

Directionstep: [NE | 14 Ipxs] | X

Directionstep: [sw =] 16 Ipxs] | X

Add direction step

Update |




When you click on the edit or delete button of a band you reach this “create/edit” page again
and you can make your changes, but by clicking on the title of the band (in this case
“myBand”) you reach the page where you can add additional preparation steps or mass
spectrometry experiments to the band.

At the bottom of the page the annotated image is shown (for demonstration purposes only an
arbitrary image is shown). The localization of the band can be described in three different
ways. The boundary chain is depicted in the image above.

Rectangle:
| LocalisationltemType: | Iﬁectangle j
Z-Coordinate: [px] ?
¥-Coordinate: [px] ?
x-Size: [px=] ?
¥-Size: [px=] ?
Boundary points:
| LocalisationfternType: | IEh:lLlndarj,f Faints j
Boundarypoints: ?
x [px] || Y: [px]
x [px] || Y: [px]
x [px] || Y: [px]
Add boundary point

X
X
X

For the boundary chain and the boundary points the sequence of the entered values is

important.

4.3 Gel2D:



Sample testSample ¥ Edit Display Settings

Gel 1D
add Gel 1D

Gel 2D
add Gel 20

Lc Columns

add Lo Column

Otheranahte Processing Steps
add Other Analyte Processing Step

Chemical Treatment Processing Steps

add Chemical Treatment Processing Step
Massspec Experiments

addfiremove Massspec experiments

When you are on the page of a sample or an analyte you can add a Gel2D with the link “add
Gel 2D”. When you have added a Gel2D you will be redirected to the previous page
containing the added Gel2D.

Gel 2D

Hr. | Description | PercentAcndamide | StainDetails | PiStart | PiEnd | MassStarnt | MassEnd

1| myGel2d &5 | X

add Gel 2D

When you click on the description name or on the edit button you will be directed to the
“create/edit” page again.



Ed it GEIZD & Edit Display Settings

| Gel2dld: || testlt] |

Gel Buffer Inter Dim. 'Spot Detection| [Image Acquis.l I'mage
| Aqucisition Equipments: ?
| Aqucisition Equipment: ||IaserScannerEquipment j | @ =
Add equipment
| Acquisition Softwares: ?
| Acquisition Software: ||annther80ﬁwareType 20 =] = @ =
Add image acquisition
softwares
| EquipmentCalibration: | |aut0matic j 2
Equipmment3pecificParams LI
EquipmentspecificParams: J ?
ImagelicguisitionProcess =
ImagedcquisitionProcess: ?
=
| Acquisition Component: ||Main Y j 2
Update |
add Spot
Hr. | Title Area | Intensity | LocalBackground | Annotation | AnnotationSource | Mormalisation | ApparentMass | Description
1 | testASpot 15 2.0 30 Annotation | AnnotationSource | 2440 6.0 Description ﬂ' x
2 | aCircle E:cff x
3 | boundaryFPoints ﬁ X

For the “Acquisition Component” you can select the whole selected “Gelmatrix” for X and Y
named with “Main X” and “Main Y (you will find this select field, when you click on the
“Gel” tab) or one of the components of the “Gelmatrix X “Gelmatrix Y. The references to
the files (mostly images) which you can select in the “Image” tab, must be uploaded with the
following upload types: Gel2D Raw Image for the Raw Image; Gel2D Warped Image for the
Warped Image; Gel2D Warping Map for the Warping Map; Gel2D Annotated Image for the
Annotated Image. All of the images can be displayed on this page as well. In contrast to the
GellD the input mask is quite often divided by additional tabs in information concerning the
X and concerning the Y section.



Gef Buffer Inter Dim.  Spot Detection Image Acquis. Image

Buffer X | Buffer ¥ l
BufferProtocol¥z =
BufferProtocolY: ?
| Running Buffers: | ?
| Running Buffer: ||anutherEluﬁer =| = @ X
| Running Buffer: ||TEStAdding j | @ X

Additionally to the create page link the “add Spot” link for adding spots and a list with added
spots will be displayed.



New Spot

| area: 15 12
(e 20 12
T =0 ]2
[ [P 2
lﬂmutu!lmﬁu.mm ||Annn13tinn5|:rurca | ?
| Volume: ||4.ﬂ I 2
| Normalisation: [anotherOne 5@ ?
| Normaisedyolume: 55 | 2
|nppamrmu ||.E.[I | z
|ﬁpwml’t ||?.EI ?
Description Al
Description: .
| LocalisationttemType: |Boundary Chain =
[ Boundurypoinia: | 2
% |10 IE 20 | 2
Iﬂrucﬁmmm "EE—H 3 . Ipxs] | X
||:nm¢unnate:p= §|IE -ﬂ |4 | [pusl:x
Directionstep: | Co—= G | tors1 X
Imnuﬁmmup: ||N‘1-'I-" o 7 lﬁ)(
| Dicectionstep: [ e | mest [
| Directionstep: |r3‘-'-" i BE ! [pxs] |}<
[I]lucﬁcm-uqu |m _1I3 ﬁl [lmll)(
Add direction step

When you click on the edit or delete button of a spot you reach this “create/edit” page and you
can make your changes, but by clicking on the title of the band (in this case “mySpot”) you
reach the page where you can add additional preparation steps or mass spectrometry
experiments to the spot.

At the bottom of the page the annotated image is shown (for demonstration purposes only an
arbitrary image is shown). The localization of the spot can be described in three different
ways. The boundary chain is depicted in the image above.



Circle:

LocalisationtemType: || Circle j
X-Coordinate: 1.0 [px] Pad
¥-Coordinate: 2.0 [px] pad
Radius: 3.0 [px=s] ?
Boundary points:
| LocaligationtemType: || Boundary Paints j
Boundarypoints: ?
E 1.0 [px] || ¥: || 2.0 [px] X
30 exl || v: |[4.0 [px] X
Add boundarny point

For the boundary chain and the boundary points the sequence of the entered values is
important.

4.4 LC-Column:

Sample testSample ¥ Edit Display Settings

Gel 1D
add Gel 1D

Gel 2D
add Gel 20

Lc Columns

add Lo Column

Otheranahte Processing Steps

add Other Analyte Processing Step

Chemical Treatment Processing Steps

add Chemical Treatment Processing Step

Massspec Experiments

addfiremove Massspec experiments

When you are on the page of a sample or an analyte you can add a LC-Column with the link
“add Lc Column®. When you have added an LC-Column you will be redirected to the
previous page containing the added LC-Column.



Lc Columns

Hr. | Title Description | InternalLength | InternalDiameter | FlowRate | Injectionolume

1 | myColumnExperiment ﬁ

add Lc Column

When you click on the title name or on the edit button you will be directed to “create/edit”
page again.

Title: || test
L C Cofumn | Run Phases | Pun Setfings Detection
Mobile phase components ?
| Mobile phase component: || myFirstComponent ‘ ‘ 1.0 |x
| Mobile phase component: | | mySecondComponent2 ‘ ‘ 2.0 | >

Add mobile phase component

Gradient step 1: ?
| Gradient Type: |||:Dnstant j | 12.0 | ‘ [min] |
| Purpose: ||aGDUdF‘urste j @ ?

Composition

| Component: ||mySecondCDmponent2 j 2.0 »

Add component

| Type: | [calibration and washing l® ?

| substance: ' |oneMoreTEstwWithOneCompon | g @ 2
|Time || 1.0 ?

||||'D|ume ||2.D ? %

Add between run

Gradient step 2: ? %
| Gradient Type: ||gradient -] | 120 | ‘ [min] |
| Purpose: ||a5dfasdf j @ ?
Composition
| component: | [mySecondCompanent2 B EL |40 %
| component: | [myFirstCompanent! =l [120 | 140 %

Add component
Add between run

Add gradient step

Update |

add Fraction
Hr. | Fractionld | StartPoint | EndPoint | ProteinAssay

1| fasfafd 1.0 2.0 2.0 =R




In this page you can enter different mobile phase components, which you can select (after
entering) in the component select field.

Additionally to the create page link the “add Fraction™ link for adding fractions and a list with
added fractions will be displayed.

Edit Fraction

o
£ Details for the start point X

Time of start of fraction of interest

Fractionld: | fasfafd pid
StartPoint: | 1.0 ?
EndPoint: | 20 ?
ProteinAssay: | 30 s

Update |

When you click on the edit or delete button of a Fraction you reach this “create/edit” page and
you can make your changes, but by clicking on the title of the fractionld (in this case
“firstFraction”) you reach the page where you can add additional preparation steps or mass
spectrometry experiments to the fraction.



4.5 Chemical Treatment:

Sample testSample ¥ Edit Display Settings

Gel 1D
add Gel 1D

Gel 2D
add Gel 20

Lc Columns

add Lo Column

Otheranahte Processing Steps

add Other Analyte Processing Step

Chemical Treatment Processing Steps

add Chemical Treatment Processing Step

Massspec Experiments

addfiremove Massspec experiments

When you are on the page of a sample or an analyte you can add chemical treatments with the
“add Chemical Treatment Processing Step“link. When you have added a chemical treatment
you will be redirected to the previous page containing the added chemical treatment.

Chemical Treatment Processing Steps

Hr. | Digestion Dertvatisations
1 | twpsinDigestion ECE )(

add Chemical Treatment Processing Step

When you click on the digestion name or on the edit button you will be directed to the same
“create/edit” page again.



Show Chemicaltreatment @ Edit Display Settings

Digestion: trypsinDigestion

Derivatizations:

add Treated Analyte

Hr. | Description

1 | myTreatedSample Eﬁ }(

Additionally to the create page link the “add Treated Analyte” link for adding treated analytes
and a list with added treated analytes will be displayed.

New Treatedanalyte

De=scription:

Create |

When you click on the edit or delete button of an treated analyte you reach this “create/edit”
page again and you can make your changes, but by clicking on the name of the description (in
this case “myTreatedSample”) you reach the page where you can add additional preparation
steps or mass spectrometry experiments to the treated analyte.



4.6 Other Analyte Processing Step:

Sample testSample ¥ Edit Display Settings

Gel 1D
add Gel 1D

Gel 2D
add Gel 20

Lc Columns

add Lo Column

Otheranahte Processing Steps
add Other Analyte Processing Step

Chemical Treatment Processing Steps

add Chemical Treatment Processing Step

Massspec Experiments

addfiremove Massspec experiments

When you are on the page of a sample or an analyte you can add other analyte processing
steps with the link “add Other Analyte Processing Step®. When you have added an other
analyte processing step you will be redirected to the previous page containing the added other
analyte processing step.

Otheranalyte Processing Steps

Hr. | Hame

1 | otherAnalteProcessingStep ﬁ )(

add Other Analyte Processing Step

When you click on the name or on the edit button you will be directed to the same
“create/edit” page again.



Edit Otheranalyteps Fb Edit Display Settings

‘ Hame: ” otherfnalytePracessingStep

Update |

add other analyte

Nr. | Name

1 | otherAnalyte ﬁ x

Additionally to the create page link the “add other analyte” link for adding other analytes and
a list with added other analytes will be displayed.

New Otheranalyte

Hame:

Create |

When you click on the edit or delete button of an analyte you reach this “create” page and you
can make your changes, but by clicking on the name (in this case “otherAnalyte’) you reach
the page where you can add additional preparation steps or mass spectrometry experiments to
the otherAnalyte.



4.7 Adding of Massspec experiments

Sample testSample ¥ Edit Display Settings

Gel 1D
add Gel 1D

Gel 2D
add Gel 20

Lc Columns

add Lo Column

Otheranahte Processing Steps

add Other Analyte Processing Step

Chemical Treatment Processing Steps

add Chemical Treatment Processing Step

Massspec Experiments

addfiremove Massspec experiments

When you have added some mass spectrometry experiments, there is a direct link on the title
of the mass spectrometry experiment to the mass spectrometry experiment.

When you are on the page of a sample or an analyte you can add other mass spectrometry
experiments using the “add/remove Massspec experiments‘link.

Massspecexperiment ® ouery [ EditDisplay Settings
Massspecesperiments per page: 15 [25] 50 100 Massspecexperiments per page: 15 [25] 50 100
1 Massspecexperiments found | Page1of1 go to page I:l go T Massspecexperiments found Page 1of1 | go to page I:l go
Name | Raw File Name Raw File
I~ | testExp [T Phosphb_bga_2htoll
[T | Phosphb_bsa_shto1l
Massspecesperiments per page: 15 [25] 50 100
1 Massspecexperiments found Page 10f1 go to page |:| go S [T | Phosphb_bsa_1htos|
—I [T | Phosphb_bsa_1hto2l
il [ | Phasphi_bsa_1htol
[T | Phosphb_bsa_10htatl
[T Phosphb_bsa_1htol0l
Massspecexperiments per page: 15 [25] 50 100
7 Massspecerperiments found Page 1 0f1 go to page |:| go
Return

Adding massspec experiments to an analyte works the same way as adding samples to
experiments (see chapter 3.2.2). The only difference is that only those mass spectrometry
experiments are displayed on the left side, which are not already added to an analyte, while



the sample can be added to several experiments. For detailed information how to create mass
spectrometry experiments see 6.1 “Mass spectrometry experiment”.

4.8 Gel Substance

By clicking Sample Processing->GelSubstance you reach gel substance section.

Sample Generation
Sample Processing

w Gelsubstance
Add Gelsubstance
Find All GelsSubstances

F Gelmatrix

F Buffer

F Detectionagent

F Reagent

Mas=s Spectrometry
MS-Analy=sis

Management

With the “Add GelSubstance” you can add gel substances.

New GelSubstance

Gelzubstanceld:

Component 1 }(

Hame:

Concentration: [mmol]

Component 2 X

Hame:

Concentration: [mmol]

Add a component

Create |

With a click on the button “Find All GelSubstances” you get an overview of all your gel
substances:



G a I S u bstan ce ® Query & Edit Display Settings

GelSubstances per page: 15 [25] 50 100
6 GelSubstances found Page1of1 | go to page |:| go

Hr. | Gelsubstanceld

1 | anotherSubstance

2 | myGelSuhstance

3 | claudias

4 | tesdfsafasdfas

5 | sdfaf

By Bl Bs| By Bs B
B 888 ee
X X[ X[ X|X| X

6 | testGelZdSubstance

GelSubstances per page: 15 [25] 50 100
6 GelSubstances found | Page1of1 go to page |:| go

4.9 Gel Matrix

By clicking Sample Processing->Gelmatrix you reach gel matrix section.

Sample Generation
Sample Processing
F GelSubstance

w Gelmatrix
Add Gelmatrix
Find All Gelmatrices

F Buffer

F Detectionagent

F Reagent

Mass Spectrometry
M5-Analysis

Management

With the “Add Gelmatrix” you can add gel matrices.



New Gelmatrix

Gelmatrixid:

"

DescriptiveHame: I j

@
MatrixType: I j @ E
[x]

[»]

Percentage acrylamide: E
Acrylamide:bisacnylamide: E
Gel Part *

Hame: I j @ E
B =[]

Percentage acrylamide: E
Acrylamide:bisacnylamide: E
Gel Part pd

Hame: I j @ E
B =[]

Percentage acrylamide: E
Acrylamide:bisacnylamide: E

Add a component

Cmmel

With a click on the button “Find All Gelmatrices” you get an overview of all your gel
matrices:



G EI 11 atri X /% Query 56 Edit Display Settings

Gelmatrixs per page: 15 [25] 50 100

4 Gelmatrizs found Page 1 of 1 go to page |:| go
Hr. | Gelmatrixld DescriptiveMame
1 | testGelMatrix3 | slab gel EREIRe
2| myMatrix IPG strip =LA
3 | testGelMatrix2 | IPG strip =LA
4 | testGelMatrix | IPG strip =LA
Gelmatrixs per page: 15 [25] 50 100
4 Gelmatrizs found Page 1 of 1 go to page |:| go

4.10 Buffer

By clicking Sample Processing->Buffer you reach buffer section.

Sample Generation
Sample Processing
} GelSubstance

} Gelmatrix

w Buffer
Add Buffer
Find All Buffers

F Detectionagent

F Reagent

Mas=s Spectrometny
MS-Analysis

Management

With the “Add Buffer” you can add buffers.



New Buffer

Bufferld:

BufferType: I j @

Component 1 X

Hame:

Concentration: [mmol]

Component 2 X

Hame:

Concentration: [mmol]

Add a component

Create |

With a click on the button “Find All Buffers” you get an overview of all your buffers:

® Query § Edit Display Settings

Buffers per page: 15 [25] 50 100
6 Buffers found | Page1of1 | go to page |:| go

Nr. | Bufferld

1 | letsTryOneMoaoreBuffer

2 | anaotherBuffer

3 | testadding

4 | testAddAdding

5 | testinterAdding

By| By By Bs| Bs| By

AL AL
X|X|X|X|X|X

E | testwithComponents

Buffers per page: 15 [25] 50 100
& Buffers found | Pagedofi1 | go to page |:| go

4.11 Detection agent

By clicking Sample Processing->Detectionagent you reach detection agent section.



Sample Generation
Sample Processing
} GelSubstance

b Gelmatrix

} Buffer

+ Detectionagent
Acld Detectionagent
Fincd All Detectionagents

} Reagent
Mazs=s Spectrometry
MS-Analysis

Management

With the “Add Detectionagent” you can add detection agents.

New Detectionagent

Com— i
| PurposeDescription: || =] @
|AgentManufacturer: || @

| AgentModel: || ‘

OriginDescription:

| VYolume: || ‘

| Concentration: || ‘

| Antibody 1: |
| Specificity: || j @

| Species: || ‘

| Target: || ‘

| Antibody 2: | X
| Specificity: || j @

| Species: || ‘

| Target: || ‘

Add antibody

Create |



With a click on the button “Find All Detectionagents” you get an overview of all your
detection agents:

Detection age nt ® query [ Edit Display Settings

Detectionagents per page: 15 [25] 50 100
4 Detectionagents found Page 1 0f1 go to page |:| go

Nr. | Hame

1 | myDetecttgent

2 | hullvalues

3 | detectagent

By| Bs| Bs| By
B2 ee
X[ X|X|X

4 | anotherDetecthgent

Detectionagents per page: 15 [25] 50 100
4 Detectionagents found Page 1 0f 1 go to page |:| go

4.12 Reagent

By clicking Sample Processing->Reagent you reach reagent section.
Sample Generation
Sample Processing
F GelSubstance
F Gelmatrix
F Buffer
F Detectionagent

+ Reagent
Add Reagert
Find All Reagents

Mass Spectrometry
MS-Analysis

Management

With the “Add Reagent” you can add reagents.



New Reagent

Reagentld:

Component 1 }(

Hame:

Concentration: [mmol]

Component 2 }(

Hame:

Concentration: [mmol]

Add a component

Create |

With a click on the button “Find All Reagents” you get an overview of all your reagents:

Reag ent ® oQuery [ Edit Display Settings

Reagents per page: 15 [25] 50 100
4 Reagents found Page 1 of 1 go to page |:| go

Nr. | Reagentld Compaonents

1 | testinterdimAdding

2 | testReagent compl 1.0 mrmaol

Tcaomp 1.0 mmaol

3 | anotherReagent Zcomp 2.0 mmol

By| By B B
B2 ®B®
X| X | X| X

4 | oneMareTEStAithOneCompanent | oneCampanent 100.0 mmal

Reagents per page: 15 [25] 50 100
4 Reagents found Page 1 of 1 go to page |:| go

5. Mass Spectrometry:

This section describes machine and software settings for the mass spectrometry experiment.

5.1 Mass Spectrometry Machine:

The main part of this section is the mass spectrometry and the other parts (except
“Controlsoftware” see chapter 5.5 “Control Software”) are linked to this part. There are two



ways how to reach this part. The first one is by the link in the create/edit page of the mass
spectrometry experiment (see chapter 6.1 “Mass spectrometry experiment”), the second one is
by clicking on Mass Spectrometry->Massspecmachine.

Sample Generation
Mazss Spectrometry
F lonsource

F Mzanalysis

F Detection

» Massspecmachine
Add Mazzspecmachineg

Finc &l
Mazsspecmachines

F Controlsoftware
MS-Analysis

Management

With the “Add Massspecmachine” you can add new mass spectrometry machines.

New Massspecmachine

| |
Manufacturer: | ;l @
ModelName: ‘ |
ManufactureDate: ‘ ‘B
lonsource: | j @
Mzanalysis: | = @
| Detection: “ @
| TuneFile: H |
| MethodFile: H |
i
SignificantCustomizations:
Add details for an MS-level
r
Owned by Inst.: [
|Inse[m U255 j

Create



If your desired ionsource,mz analysis or detection is not in the list you can add it directly with
the blue button on the right side of the select field. Read more about organisms in chapter 5.2
“lonsource”, about mz analysis in chapter 5.3 “Mzanalysis” and about detection in chapter 5.4
“Detection”. The links “Add details for an MS-level” add details for each MS-level. You
should enter details for all used MS-levels. With the links at the top for “Filter” and “Query”
you can specify machine-specific filters for the upload (see 6.2) or machine specific default
filters for the protein/clustered view (see 7.1).

With a click on the “Find All Massspecmachines” button you get an overview of all your
mass spectrometry machines:

Massspecmachine ® Query § EditDisplay Settings

Massspecmachines per page: 15 [29] 50 100
1 Massspecmachines found Page 1 of 1 go to page go

Nr. | Name ModelMame |

1 | myMassspecmachine | myMadel 1) ﬂlx

Massspecmachines per page: 15 [29] 50 100
1 Massspecmachines found Page 1 of 1 go to page go

5.2 lonsource:

By clicking Mass Spectrometry->Ionsource you reach the ionsource section.

Sample Generation
Mas=s Spectrometry

W lonsource
Add lonzource

Find Al lonsources
F Mzanalysis
F Detection
F Massspecmachine
p Controlsoftware

MS-Analysis

Management

With the “Add Ionsource” you can add new ionsources.



New lonsource

Hame:
= |
2 ESI
| Owned by User: | MALDI
other
Owned by Inst.:
e Bioinformatics Group j

There are 3 types of ionsources (Electrospray chapter 5.2.1, MALDI 5.2.2 and other 5.2.3)
available and the input page changes correspondingly.
With a click on the button “Find All Ionsources” you get an overview of all your ionsources:

I onsource M Query & Edit Display Settings

lonsources per page: 15 [25] 50 100

9 lonsources found | Page1of1 | gotopagel:|gn
Nr. | Hame Type

1 | test Esl |2 88| X
7 testt Esl | 88| X
3 | maldiT MaLDl |5 |88 | X
4 | tessiE54B4T s | cF (88| X
5 | tests Esl | (88| X
& | testMalDIEmpty maLDl | EF |83 X
7 | testother other |5 |88 | X
8 |testForMassspecmachine | ESI 88| X
a | oneMoreTest 88X

lonsources per page: 15 [25] 50 100
9 lonsources found | Page1of1 | go to page |:| qo



5.2.1 Electrospray:

New lonsource

|Hame: || myTestlonSource

[Type: [esi [

Supply
| SupplyType: || fed j @
| Cycletime MS1: || || [ms] ‘}(
Add Cycle Time

Solvent

| SolventComposition: || j @

SolventFlorate: | |

SolventFlowrateUnits: | j @

Interface

InterfaceManufacturer | :I @

InterfaceHame: |

InterfaceCatalognumber: ||

InterfaceDescription:

Sprayer
| SprayTipManufacturer: || j @

| Sprayerdame: ||

| SprayerCatalognumber: ||

| SprayerCoating: || j @

SprayerDescription:

SprayTipWoltage: | ” vl ‘

SprayTipDiameter: | |

| ConeVoltage: || ” [v] ‘

Acceleration and Dissociation

Acclerationvoltage MS1: || ” [v] ‘x
Add Accelerationvoltage
| InSourceDissociation: || false j
HebulisingGas: | ﬂ @
HebulisingGasPressure: | ” [bar]

Create |



When you change the type to “ESI”, you get the electro spray input form. When you change
the “SupplyType” to “fed” then the link “Add Cycle Time” appears and you can enter cycle
times for all your MS-levels. In the section “Aceleration and Dissociation” there exists a
second link “Add Accelerationvoltage”, where you can enter the acceleration voltages for
each MS-level.

5.2.2 MALDI:

New lonsource

| Hame: || |

| Type: [MALDI =~

Plate and Matrix
| PlateComposition: || j @
| MatrixComposition: || ﬂ @

DepositionTechnique:

Voltage Settings
[sravotage || [m ]
Add Accelerationvoltage

Post Source Decay

| PsdType: || ﬂ @

| PsdDescription: ||

| ExtractionDelayed: [false =]

Laser Settings

| LaserType: || _ﬂ @

| LaseriWavelength: || || [nm] |

| LaserPower: || || [microJ] |

| FocusDiameter: || || [microm] |

| AttenuationDetails: || |

| PulseDuration: || || [ns] |

| ShotFrequency: || || [Hz] |

| AvgNrOfShotsFiredOnSpectrum: || |

|OwnedbyUser: ||_

| Owned by Inst.: | W |Biuinf0rmatics Group j

Create



When you change the type to “MALDI” then you get the MALDI input page. Use the link
“Add Accelerationvoltage” to enter the acceleration voltages for each MS-level.

5.2.3 other:

Edit lonsource

Name: other
Type: " other j
Description o
Description:
-

Owned by User: | v

-
|Eli|:|inf|:|rmati|:5 Group j

Owned by Inst.:

Return | Update |

When you change the type to “other” then you get the other ionization input page. There is
only an input field for the description of other ionization techniques.

5.3 Mzanalysis:

By clicking Mass Spectrometry->Mzanalyisis you reach the mzanalysis section.

Sample Generation
Mass Spectrometry
F lonsource
+ Mzanalysis
Addd Mzanalysis
Find All Mzanalysis

b Detection

¥ Massspecmachine
p Controlsoftware
MS-Analysis

Management

With the “Add Mzanalysis” you can add new mz analysis apparatus.



New Mzanalysis

| Owned by User: |

Owned by Inst.:

lon Optic

Quadrupole
Hexapole
TOF

lon Trap
FT-ICR
other

There are 7 types of mz analysis apparati (Ion optic chapter 5.3.1, Quadrupole chapter 5.3.2,
Hexapole chapter 5.3.3, TOF chapter 5.3.4, Ion Trap chapter 5.3.5, FT-ICR chapter 5.3.6 and
other 5.3.7) available and the input page changes correspondingly.

With a click on the button “Find All Mzanalysis” you get an overview of all your mz analysis

apparati:

Mzanalysis

® query & Edit Display Settings

4 Mzanalysiss found

Nr. | Name Twpe

1| sdaf lan Cptic &5 88
2 | iontrap lon Trap 88| X
3 | massspecMachineTest | FT-ICR ﬁ &l x
4 test? auadrupole |2 | 83 | X
4 Mzanalysiss found

Mzanalysiss per page: 15 [25] 50 100

| Pagelofi | gotupagemgo

Mzanalysiss per page: 15 [25] 50 100

| Page1ofi | gotupagemgu



5.3.1 Ion optic:

New Mzanalysis

Hame:
Type: || lon Optic ;i
F
Description:
=
| Collisioncell: | r

|0w1wedh3rl.lser: ||-

2
|Eiiuinfc+rmatics Group j

Owned by Inst.:

Create

For the ion optic only a description field is necessary. All of the mzanalysis types have a
check box where you can enter details about the collision cell (see chapter Collision Cell
5.3.8).

5.3.2 Quadrupole:

Same input page like ion optic see 5.3.1.

5.3.3 Hexapole:

Same input page like ion optic see 5.3.1.




5.34TOF:

New Mzanalysis

Hame:

| Type: |ToF ~|
ReflectronState: I il @
InternalLength:

| Collisioncell; | r

| Owned by User: | O
|{)rwnedh3rlnst.: | v IE!iuinformatics Group j

et

All of the mzanalysis types have a check box where you can enter details about the collision
cell (see chapter Collision Cell 5.3.8).

5.3.5 Ion Trap:

New Mzanalysis

Name: | |

Type: I lon Trap j

GasType:

‘ GasPressure: || ” [bar] |

‘ RfFrequency: || ” [HZ] |

‘ ExcitationAmplitude: ||

‘ IsolationVidth: ||

IsolationCenire: || |

‘ FinalMsLevel: ||

| Collisioncell: I=

| Owned by User: | ||
| Owned by Inst.: | [~ IBioinformatics Group _1'

Gﬂeﬁel



5.3.6 FT-ICR:

Same input page like ion trap see 5.3.5.

5.3.7 Other:

Same input page like ion optic see 5.3.1.

5.3.8 Collision Cell:

New Mzanalysis

Name:

Type: " other ﬂ

Description:

Collisioncell: | W

e | Je

GasPressure: [bar]

CollisionDffset:

CollizionEnergy:

| Orwned by User: | O
| Owned by Inst.: | ¥ |Eiiuinfnrmatics Group j

When you check the “Collision cell” check box you can enter information about the collision
cell.

5.4 Detection:

By clicking Mass Spectrometry->Detection you reach the detection section.



Sample Generation
Mas=s Spectrometry
¥ lonsource

F Mzanalysis

w Detection
Addd Detection
Find All Detections

F Massspecmachine
p Controlsoftware
MS-Analysis

Management

With the “Add Detection” you can add a new detector.

New Detection

Hame:

Type: j @
Detectorsensitivity:

RateOfDataAcquisition: [GHz]

Craate |

With a click on the button “Find All Detection” you get an overview of all your detectors:

Detecti 0 n ® Query @ Edit Display Settings

Detections per page: 15 [25] 50 100
3 Detections found | Pagedofi1 | go to page I:l go

Mr. | Name Type

1 | testForMassspecexperiment | channeltran

2 | hlabla micrachannel plate

Bl B By
LA
X[ XX

3 | masspecMachineDetection | channeltron

Detections per page: 15 [25] 50 100
3 Detections found | Page1of1 | gotopage[ |go



5.5 Control Software:

The control software is needed for mass spectrometry experiments (see chapter 6.1 “Mass
spectrometry experiment”). By clicking Mass Spectrometry->Controlsoftware you reach the
control software section.

Sample Generation
Maz=s Spectrometry
b lonsource

F Mzanalysis

b Detection

F Massspecmachine

w+ Controlsoftware
Add Contr Softwes
Find Al Cartr Softw =

MS-Analysis

Management

With the “Add Contr.Softws” you can add new control software.

New Controlsoftware

PackageName:

Izolation\WWidth:

Criterias
Criteria: x

Add Criteria

Softwares

Software: I j @ x

Add Software

|Dwnedh3rUser:| -

| Owned by Inst.: | ¥ |Eiic+inﬁ:+rrnatic5 Group j

Create |



With the link “Add Criteria” you can add switching criteria. With the link “Add Software”
you can add software, which the control software consists of. If your software is not in the
selection list you can add it with the blue button and you come to the create software page
(see chapter 2.4 “Software”).

With a click on the button “Find All Contr.Softw.s” you get an overview of all your control
software:

CO ntro I Sﬂftwa re % guery & Edit Display Settings

Controlsoftwares per page: 15 [25] 50 100

4 Controlsoftwares found Page 1 of 1 go to page |90
Hr. | PackageName | Softwares
1 | sdfastda c (88 X
2 | MyTestPackage 288X
KCalibur 2.0
3 | testt mySoftw 1.0 | £ | 83 | D¢
4 |tests ch |88 | X
Controlsoftwares per page: 15 [25] 50 100
4 Controlsoftwares found Page 1 of 1 go to page 'gu

6. Mass Spec Experiment and File Uploading:

This section describes the generation of mass spectrometry experiments and how you can add
searches from different search engines to them.

6.1 Mass spectrometry experiment:

By clicking MS-Analysis->Massspecexperiment you reach the mass spectrometry experiment
section. This is a central point, where all the information is linked to one another.

Sample Generation
Mazs Spectrometrny
MS-Analysis

w Massspecexperiment

Add MZ-Experiment
Find Al MS-Experimerts

Management

With the “Add MS-Experiment” you can add new mass spectrometry experiment.



New Massspecexperiment b Edit Display Settings

Hame: ”

GenerationDate: | | B

Massspecmachine: I j @

Control and Analysis Software:

Parameters File: | | @
®

Raw File: ” |

L

Description:

Owned by User: O
| Owned by Inst.: | I~ IBioinformatics Group j

Create

If the desired mass spectrometry machine is not in the select box you can click the blue button
on the right side of the select box and you will reach the create page of the mass spectrometry
machine (see chapter 5.1 “Mass Spectrometry Machine”). If the desired control and analysis
software is not in the select box, click the blue button on the right side of the select box and
you will reach the create page of the control software (see chapter 5.5 “Control Software”).
To select a raw File click the blue button next to the “Raw File” input field. The following
page will appear:



File Upload

% Query % Edit Display Settings

Selected File: | BSA_A00fmHE_&0fmDG Clean selection Accept Selection
Files per page: 15 [25] 50 400
13 Files found Page 1 of 1 go to page |:| go
Hr. | Upload Name Category
1 | casein_ML_MS3 rawdata
2 | BSA_500fmHE_S0fmDA rawdata
3 | OBOBN6FTc2_phosphb_bsa_1hzull | rawdata
4 | Karin_IMAC_Sandra_20ul rawdata
4 | BSA_500fmHE_1000fmDE& rawdata
B | Franz2 rawidata
T | BCA_Gr2_2a rawdata
& | B3A_S00fmHE_1000fmDE rawdata
9 | h_051019204752 rawdata
10 | BCA_Y rawdata
11 | BCA_P1_postZipTip rawdata
12 | Franz? rawdata
13 | 060581 2FTec1_Andreas_As0 rawdata
Files per page: 15 [25] 50 400
13 Files found Page 1 of 1 go to page |:| go

Return |

A list of all the raw files uploaded appears. When you click any of the “Upload Names” in the
list the name will appear in “Selected File” field. With “Clean selection” you can clean the
entry again. With “Accept Selection” this raw file is accepted for that mass spectrometry
experiment and will be used for quantitative evaluations, and you return to the create page of
the mass spectrometry experiment. If you want to add your mass spectrometry experiment to
an analyte, see chapter 4.7 “Adding of Massspec experiments”.

With a click on the button “Find All MS-Experiments” you get an overview of all your mass
spectrometry experiments:



Masss pecexpe riment ® Query @ FEdit Display Settings

Massspecexperiments per page: 15 [25] 50 100

31 Massspecexperiments found | Paged1of2 | Hext:>> go to page |:| go
Hr. | Name Raw File GenerationDate

1 testiarl i |88 | X
2 | MascotCompToSequest ﬁ -1 x
3| ShNew-hay i 88| X
4 | 060512FTc!_Andreas_A50 RAN | 06051 2FTel_Andreas_AS0 Eﬁ & x
5 | SequCompToMaseot 2006-07-13 (83 | X
£ | MascotCompSpecthill (88| X
7| test2 2006-07-13 ch (88 X
8 | compMz<MLANR s Franzz2 ETHE - AP
9 | test3 =R
10 | compDifrerentEngines 060B06FTe2_phasphb_bsa_thzull | 2006-07-12 ﬁ & x

6.2 File parsing into MASPECTRAS:

When you click on the name of the mass spectrometry experiment or the edit button, you will
get the following view of your mass spectrometry experiment:



Edit Massspecexperiment § EditDisplay Settings

| Hame: ” compDifferentEngines

| GenerationDate: | 12.07 2008 | @

| Massspecmachine: ||testr\f1achine j @
Control and Analysis Software: || MyTestPackage @
ParametersFile: |

| Raw File: || DBOBOBFTE2_phosphis_bsa_thzul @
Description:

Returm | Update |

Added Searches

UploadName PrepSteps
0B0E0EFTe2_phosphb_hsa_1hzull Sample: test
Mascotthzull Sample: test

0B0E0EFTe2_phosphh_hsa_1hzullSequest Samnple: test

060B0BFTe2_phosphb_hsa_1hzuliSpectrMill | Sample: test

bsa_1hzullxTandemn Sample: test

add Massspec searches

Compare Results |

When you follow the link “add Massspec searches”, you will get a page where you can upload
you search results from Sequest, Mascot, Spectrum Mill, X! Tandem, or OMSSA.

The thresholds are necessary to remove the most unlikely data. The peptide prophet threshold
affects Sequest and Mascot only. For SpectrumMill (new version) you have to specify your
Spectrum Mill Config File (smconfig.xml) and if you have added modificitations also the
Spectrum Mill User Config File (smconfig.custom.xml). For OMSSA you have to specify the
Omssa Modifications File (mods.xml). The A means the allowed threshold difference between
the first and the rest of the found hits for one search. The “Min Peptide Length” specifies how
many amino acids a peptide must have at least and the “# Peptides for protein” specifies how
many peptides have to be found to accept a protein. With the “Alignment” option you can
specify if an alignment of the sequence based clustering has to be done by ClustalW. The
reason why this option has been made was that it was a time consuming step and that there
was much more disk space consumption with the alignment. If you select “NONE” the only
thing not possible is the clustered view described at 7.2. The “Just top intensity peaks” option
allows the save of disk space. It is specifiable how many (the ones with the best intensity)



should be store (e.g. if you enter 100 the 100 peaks with the highest intensity will be stored in
the database while the rest will be discarded).

File Upload ® Query @& Edit Display Settings Quant-Settings

Sequest S Threshold: 01 || & 10 |
ST e 1 O 1 PN EY T
Peptide Prophet Threshold: | 0.0 | A | 10 |
Mascot Peptide Threshold: |+1: || 15 ||+2: || 20 || 3 || 25 | A |100 |
SpectrumMill Peptide Threshold: |10 | A |100 |
SpectrumMill Config File | =l
SpectrumMill User Config File | |
XiTandem Peptide Threshold: | 30 | A | 1000|
Omssa e-Value Threshold: 120 || ¢ 1000
Omssa Madification File: | =l
CeMM InsilicoDef File: | |
Min Peptide Length: | 5 |
# Peptides for protein: | 1 |
Alignment: | Clustalw |
Just top intensity peaks: r | |

Quantification tolerance +/-miz [Dal: | 10 |

=

Files per page: 15 [25] 50 100 Files per page: 15 [25] 50 100
5 Files found Page 1 of 1 t
187 Files found Page 1 of & )Eex't go to page|:|go ties foun ageto ae opagemgo
Upload Name Category
L3S0 T T I~ | 060G0GFTc2_phosphb_bsa_ihzuliSequest | sequest
Taskims22400-3601 sequest
[~ | bsa_1hzullXTandem xtandem
Mascothist mascot
[~ | 0B0B0GFTCc2_phosphb_bsa_1hzullOMSSA omssa
MascProbe1F001927 mascot
I~ | Mascotthzuil mascot
PhosphoRealData mascot
[~ | 0B0B06FTCc2_phosphb_bsa_1hzullSpectrMillzip | spectrummill
Task3karlDBMS3 sequest
ICPL_Protmix_1lizuthe_A_c1_XTandem | xtandem Files per page: 15 [25] 50 100
ICPL_Protmix_1lizuzhe_A_c2_ms2 mascot § Files found Page 1 of 1 gotopage[ |go

ICPL_Protmix_10lizu1he_A_c1_ms2.dat | mascot

ICPL_Protmix_10lizu1he_B_ci1_ms2.dat | mascot

ICPL_Protmix_10lizu1he_C_ci1_ms2.dat | mascot

ICPL_Protmix_1lizu10he_A_c2_ms2.dat | mascot

ICPL_Protmix_1lizu10he_B_c2_ms2.dat | mascot

ICPL_Protmix_1lizu10he_C_c2_ms2.dat | mascot

ICPL_Protmix_1lizuthe_B_c1_ms2.dat | mascot

e

ICPL Protmix 1lizuthe C c1 ms2.dat | mascot

The Il icon opens a new box where you can specify quantification options (if needed):



File Upload ® Query b EditDisplay Settings Quant_Settings

Sequest Sf Threshold: | 01 | A |1.U | 3
Sequest Peptide Threshold: +:|[ 156 |[+2] 2 +3: |25 | A | 1.0 | \M“ASAPR Standard j

Peptide Prophet Threshold: | 0.0 | A |1_0 | r I:I
Mascot Peptide Threshold: +: || 15 +2: || 20 +3: || 25 | A |1[][] | P ——— |0 | IR ap— |3_18 |x
SpectrumMill Peptide Threshold: | 10 | A | 100 | S ——— | 0 | T — | 0 |x
SpectrumMill Config File | | Add partner

e e I j Accept | Save Settings | Remove Stored Settings
X'Tandem Peptide Threshold: | 30 | A | 1UUU|

Omssa e-Value Threshold: | 20 | Az | 1UUU|

Omssa Modification File: I j

CeMM InsilicoDef File: | |

Min Peptide Length: | 5 |

# Peptides for protein: | 1 |

Alignment: ICluBtalW j

Just top intensity peaks: Il | |

Quantification tolerance +/-miz [Da]: | 1.0 |

savel |

These settings are for the detection of partners which are not identified by MS/MS.

With “Quant Method” you can specify the used quantification method. “ASAPR Standard” is
the standard ASAPRatio peak detection (works better with Ion Trap data) and “ASAPR Enh.
Valley” is the new version (works better with FT and Orbitrap data). In general, the more
accurate the mass detection of the mass spectrometer is the more feasible the “ASAPR Enh.
Valley”. Then you can specify which amino acids carry the modification (for C-terminus and
N-terminus write: C-term or N-term). When you just searched with a fixed modification and
you have not found partners than uncheck “Var:” (the meaning is the first partner for the
comparison a variable modification). Then in the next line you have to specify the expected
mass and time shift to the first partner/fixed modification. It is possibly to specify as many
partner modifications as you like.

Adding and removing of searches to a spot (or band) works the same way like adding of
samples to experiments works (see section 3.2.2).

After the files have been selected the following processes are started (you will see the same
steps in the Upload Status Section):

“Step 1/5 (Parsing)”: Reads the necessary file (or files), filters the data and builds the
corresponding value objects

“Step 2/5 (Transferring hits)”: Stores the found proteins into the database

“Step 3/5 (Storing peaklists)”: Stores the peaklists and the connected peptidehits and links
them to the corresponding proteins

“Step 4/5 (Calculating)”: Retrieves the protein sequences from the database (if not already
stored), calculates the proteinhit score and the sequence coverage of the
hit

“Step 5/5 (Protein Grouping)”: Clusters similar proteins together in protein groups.



After these five steps an automatic calculation of a relative quantity for each peptide is
started, when a raw file for the mass spectrometry experiment is selected (see chapter 6.1
“Mass Spectrometry Experiment’). The progress bar for the calculation starts again at 0%.
You can meanwhile validate your data. The view on the data is the same, the only difference
is that in the peak-area file you will find no value until the calculation has finished.



7. Analysis:

There are two ways to analyse (compare) your data:

1. To click directly on the upload name table below the mass spectrometry experiment
(see first picture section 6.2 “File parsing into MASPECTRAS”)
2. To use the

Compare Results

button.

You will find this button when you list your samples from one experiment (then you can
compare all searches that are in this experiment) or in a list of the “Uploaded Searches” in
the mass spectrometry experiment (see first picture section 6.2 “File parsing into
MASPECTRAS). Further buttons of that type are planned at every analyte and at every
sample processing step.

When you push this button you can select which of the uploaded searches you want to
compare. All uploaded searches below this data point are displayed. Also the preparation
steps that have been used are shown.

Searches ® Query  Edit Display Settings Quant_Settings

For Re-Quantification:

Quantification tolerance +/-m/z [Da]: ‘ | 1.0

Dbsearchparameterss per page: 15 [25] 50 4100

5 Dbsearchparameterss found Page 1 of 1 go to page |:|go

Nr. | UploadName PrepSteps
L =

v | 0G0GOGFTcZ_phosphb_bsa_1hzullSequest Sample: compareQuantification E‘ifrf B
L .

¥ | bsa_1hzullXTandem Sample: compareQuantification Eﬁrf B
[

[T | 060GORFTCcZ_phosphb_bsa_1hzullOMBSA Sample: compareCQuantification E‘irf ]
L

v | Mascotihzuil Sample: compareQuantification E‘irf B
L

[T | 0G0GOGFTcZ_phosphb_bsa_1hzullSpectrMill zip | Sample: compareQuantification Eﬁ ]

Dbsearchparameterss per page: 15 [25] 50 100
5 Dbsearchparameterss found Page 1 of 1 go to page |:|go

Accept | All | None |

Return |



When you click the = you can edit the mass values of your uploaded modifications. This
could be useful for the comparison, because the system could only group together peptides
with the same mass shift.

Hydrogen 1.0073825
Carbon 12.0
Hitrogen 14.00307
Oxygen 15.994591
Electron 5.49E-4
C_term 17 002735
H_term 1.007825
Oxidation (M) 15.9945904
HeutralLoss1 0.0
Phospho (5T) 79.966324
HeutralLoss2? 87 9763595
Phospho (¥) 79.966324
HeutralLoss3 0.0

Return | Update

The icon restarts the quantification of an uploaded file. After clicking you have to watch
the upload status page to see the progress (see 2.3). If there is no raw file specified the icon is
greyed out.

The B icon fetches or re-fetches the external information. The icon is greyed out if the
corresponding information about the external sources is not given (see 2.1). If you want to
know how to display the external information see chapter 7.4.



7.1 Protein comparison:

Protein

1 = 060B0EFTe2_phasphi_bsa_1hautl (Faritioning )
2= (HOBOEF T2 _phosphio_bsa_1hauliOmssa (Partitioning ﬂ]
3= G6060EFTe2_phosphi_bss_thauliSequest  (Faribaning By
& = DHOBOSF Te2_phosphis_bsa_ThasiTangem  (Partiioning ﬂ]

Proteins per page: 15 [26] 50 190

17 Proteins found Paged of 1 getopage g0
Nr. | Search Accessionbum | Organiem GeneNarmg Sequimviday | Score Hr. of Proteins | Amount of Pegtides
1 34| gil231300 Ddycogen Phosphondase b (£.C.2.4.1.1) (T State) Comnplex With AMP 5107 | 5104645 18 L]
2 14 pillhIEeE B bunss alburmin (B ] 420 |3y 1|4 L]
3|14 PITELEE] Homn sapiens 3313 | 35540 78 w
4 114 | ginis4ze 603 | 23730 38 o
] gINTIEITTL | Homo sapiens 592 | 18400 1[s L
6 |4 Q31560568 | Mus musculus 139 4530 1 (3 o
T |4 gil2esT Gallus gallus. 511 7000 1|2 L
8|4 il 24260 200 k] 8|2 ]
4 gllenssza1 Homn sapiens £ 1708 1|2 w
10 |4 i1 24286 046 7020 1|2 W
n s uiles0ssT 3 81+ HOmo Sapiirs (Humdei) 511 w10 (N F] L
12 |4 Q27543557 | Homo saplens 106 6250 1k o
19 4 giln24318 197 4530 1 [ L]
(T il 0aEas 2 nn 1m0 1 (1 L]
15 |4 i 24330 903, pp. &%) 173 3540 1 (1 i
16 |4 pilB250019 217 3540 i L]
17 [ lE3zEEI0 SHLCNATGMHEDS COrsian | CactE 183 1180 1 (1 L]
Proteine por page: 15 (28] S0 180
17 Protains found Paget of 1 getopege  go

T Ernin Vigw =»

To Pepiice View »»

Below the header the searches that you have selected are listed by their names and numbers
are assigned to find them in the table below. Next to the names there are links in brackets
called “Partitioning”. With these links you reach a page with a more detailed description of
the cluster (7.2).

The table below lists the found proteins. When you reach the page the proteins are clustered
together. The proteins are sorted by their sequence coverage. The protein with the best
sequence coverage is getting displayed as substitute for all the proteins in the cluster. In the
“Search” column the numbers indicate the searches, by which a protein has been found. You
can reach the combined peptide view of the protein when you click on the “GeneName” of the
protein (7.5). If you want to see the peptide view of only one search there is a link on the
number if the number is green. A red number indicates that this substitute protein was not
found with this search but another protein in the cluster has been found with this search.

The “Nr. of Proteins” column shows you how many proteins have been put together in one
cluster. When you push the blue @ button you get all proteins of that cluster listed.



Protein ® query [ EditDisplay Settings Quant-Settings

1= 060606FTc2_phosphb_bsa_1hzullSequest (Partitioning #§) 2 = bsa_1hzuilXTandem (Partitioning &) 3 = Mascotthzuil  (Partitioning )

Proteins per page: 15 [25] 50 100

4 Proteins found Page 1 of 1 gotopage|  |go
Nr. Search Acchr ‘Organism GeneName %SeqMax Score # Prots #Peps # Spec
1 123 gil231300 Glycogen Phosphorylase b (E.C.2.4.1 53.97 284053 1 64 as2 @
2 123 0il418694 validated serum albumin precursor [validated] 38.06 1308.19 2 26 543
Details from [ >
Nr. Search Acchr Organism GeneName % SegMax Score Cluster Nr. # Peps # Spec
123 0il418694 validated serum albumin precursor [validated] 3559 4130819 | Cluster-1 Cluster-7 Cluster-3 26 543
2 1123 Qi|162648 Bos taurus albumin [Bos taurus] 165 1308.19 | Cluster-1 Cluster-7 Cluster-3 26 319
Sequence x
o 50 100 150 200 250 300 350 400 450 500 550 600 650 700 750 800 850 aoo
il418694 il N 1l LR TR [l LI L]
gil162648 i} (RN It (TN TR W e i1
123 0i|999627 Chain B, Porcine E-Trypsin (EC 34 68.3 189.20 3 3 12 @ ]
4 3 Qi[1346343 Keratin, type Il cytoskeletal 1 (Cy 132 337.19 2 1 2 @

Proteins per page: 15 [25] 50 100

4 Proteins found Page 1 of 1 gotopage[ |go

Export Current View: | | |

To Protein View ==

To Peptide View ==
Return

The “Cluster Nr.” indicates the cluster where the protein is located. The order is the same as
in the “Search” column.

If you don’t want to see the clustered view at all you can click on the “To Protein View>>" at
the bottom of the page to get all proteins displayed.

Protein @ Query & Edit Display Settings

1 = DBOBOBFTCZ_phosphb_bsa_1hzutl (Pariitioning )
2 = 0BOBOBFTc2_phosphh_bsa_thzullOmssa  (Pariitioning )
3= DBOBOBFTC2_phosphb_bsa_fhzullSequest  (Partitioning )
4= 0BOBOBFTe2_phosphb_bsa_thzutlXTandem (Paritioning E)

Prateins per page: 15 [25] 50 100

7 Proteins found Page 1071 gotopage| |go
Nr. | Search | AccessionNum | Organism GeneName SequCoviax | Score Cluster Nr. Amount of Peptides
1 1234 | 0il231300 Glycogen Phosphonlase b (E.C.2.4.1.1) (T State) Complex With AMP 5397 | 5184645 | Cluster-4 Cluster-4 Cluster-3 Cluster-11 | 84
2 1234 | gil418684 validated serum albumin precursor [validated] - bovine 4037 | 3010272  Cluster-3 Cluster-3 Cluster-1 Cluster-7 40
3 124 gi[162648 Bostaurus albumin [Bos taurus] 4201 | 3018317  Cluster-3 Cluster-3 Cluster-1 Cluster-7 | 40
4 14 ail435476 Homa sapiens | cytokeratin 8 (Homo sapiens] 2312 355.40 | Cluster-1 ]
5 |4 gil1246343 Keratin, trpe Il cyloskeletal 1 (Cytakeratin 1) (K1) (CK 1) (67 kDa cytokeratin} (Hair alpha protein) 132 | 337189 | Cluster2 Cluster-2 Cluster-4 Cluster-1 | 8
B 4 0i|39794653 Homo sapiens | Keratin 1 [Homo sapiens] 132 33719  Cluster-2 Cluster-2 Cluster-1 8
704 gil71528 keratin 10, type |, cytoskeletal - human 1839 24530 | Cluster-1 7

Proteins per page: 15 [25] 50 100
7 Proteins found Page 10f1 gotopage[ |go

Export Current View:

==To Cluster View

To Peptide View =

The “<< To Cluster View” brings you back the cluster view.

The export bar lets you export the table with the selected columns in different file formats.

Export Current View: | | |

The “PRIDE XML” link generates a XML File in the PRIDE 2.0 XML Format, which is
needed to export your Experiment to the PRoteomics IDEntifications database, a centralized,
standards compliant, public data repository for proteomics data (http://www.ebi.ac.uk/pride/).



To get a valuable XML file be sure that you have entered detailed information about the
sample and the massspecmachine including for example the sample origin the
masspecmachine analyzers and detectors and the controlsoftware.

The “>> To Peptide View” brings you to the peptide view, where all the peptides of your
searches are displayed. It is the same like in 7.5 but the protein sequence is not colored.

Concerning the querying:

The meaning of most of the query fields is clear by the name they carry. And most of the
query fields are executed as directly on the database which is quite fast. The queries that are
described here are post-database filters, that means that elements that do not meet the criteria
are removed later, which takes a little bit longer:

NrOfDifferentPepSequences: a specific amount of peptide sequences (irrespective if
they are carrying different modifications) must be found for one protein in one search
NrOfSpectraForPepSequence: a specific amount of spectra must be found for one
peptide sequence in one search (irrespective if they are carrying different
modifications)

NrOfFhSpectraForPepSequence: a specific amount of first hit spectra must be found
for one peptide sequence in one search (irrespective if they are carrying different
modifications)

NrOfDifferentPepSeqAndModi: a specific amount of peptide sequences (each
modified peptide is count as a separate peptide sequence) must be found for one
protein in one search

NrOfSpectraForPepSequAndModi: a specific amount of spectra must be found for one
peptide sequence in one search (each modified peptide is count as a separate peptide
sequence)

NrOfFhSpectraForPepSequAndModi: a specific amount of first hit spectra must be
found for one peptide sequence in one search (each modified peptide is count as a
separate peptide sequence)

TotalSpectraForPepOfSearches: a specific amount of spectra must be found for one
peptide of a protein over several searches

TotalFhSpectraForPepOfSearches: a specific amount of first hit spectra must be found
for one peptide of a protein over several searches
SpectraForOneProteinFromMultiSearches: a specific amount of spectra must be found
for one protein over several searches

FhpectraForOneProteinFromMultiSearches: : a specific amount of first hit spectra
must be found for one protein over several searches

In the protein list the quantification of the proteins can be displayed, when you click on the
button.



Protein ® Query @ Edit Display Settings Quant-Settings

x
e+ 7996 W CtermDE@: 3.01 [ W%:1588 M no mod
Lower Threshold 1: | 0a | | Upper Threshold 1: ‘ 20 | Il | C¥% Warning: | RO.0 |
Lower Threshold 2: | 0.2 | I| Upper Threshold 2; ‘ a0 | CV% Threshold: | 4000 |
A it of ded peptid ” 1 | ¥ Mormalize ¥ Remove incompletely modified
Accept | Save ing: | Stored ing:
1 = dta and out pool 2_50 mM_light  (Fartiioning [
Proteins per page: 15 [25] 50 100
352 Proteins found Page 1 of 15 Hext == go to page go
Mr. | Search | AccHr il Organism GeneName YSegMax | Score | # Prots | # P
111 gil5821151 |dbj|BAAEITT 1| 33315259?9390905% Homo sapiens | RMA binding protein [Homo sapiens] 714 | 2617 2}
7 |1 1145565 24]reflP_001168085.1] 23;‘;?“83_{,93898% Pantroglodvtes | PREDIGTED: thyraid hormone recepior B.08 | 18.36 2
3 |1 gil41 581 8lemb|CAALES19.1] :::253?53%51551 4 |Homo sapiens | antigen of the monoclonal antibody 200 | 1560 1
4 |1 042542379 refINP_005830.2] B A g | Homo sapiens | serine/arginine repetiive matrix 1 432 | 1358 1
5 |1 0i[7020554|dbj|BAAGT 188.1) g\fﬁg: s5g5, | HOMO sapiens | unnamed protein prosuct [Hom sagie 1732 | 11.00 1
6 |1 gi[16553793|dhj|BABT1593.1| 33.\?—3;018%?5332% Homo sapiens | unnamed protein product [Homo sapie 5.98 | 12.45 2
711 gilf1 743954 |reflNP_001611.1]| 2)3?3220916?43% Homo sapiens | AHKNAK nucleoprotein isoform 1 [Homo 048 773 2
8 |1 81414115 2)refINP_005855.2] g\?fg;zfsgn% Horno sapiens | heterogeneous nuclear ibonucleapro 548 | 10.33 2
g |1 uil51 74535 refiNP_005500.1 e araq | Homo sapiens | microtubule-assasiated protein 18 | 189 | 9.04 1
10 |1 gil5032189|reflNP_005648.1| ; Sl Homo sapiens | tumor protein p&3 binding protein, 153 9.99 1
11 Hi56749088]sp|0BEUE4LYRIC_HUMAN gs;‘;g?fqz Protein LYRIC (Lysing-rich GEAGAMT 568 | 5.45 1
12 [1 yil5382070|refiNP_006258.2] 33\1:331;:\1292 Homo sapiens | RAN binding protein 2 [Homo sapiens 12| 9g7 3
13 [1 0i[3043596|dbj|BAAZE462.1) :::3331‘113?%‘1556% Homo sapiens | KISAD536 protein [Homo sapiens] M4 341 | 11.40 8
14 |1 gi[21 75847 0(dbj|BACO5308.1| g\ﬁfg;ﬁl Homo sapiens | unnamed protein product [Homo sapie 326 | 533 1
1911 gil8¥ 196351 |reflNP_001347.3| 33\35:\12?\1292 Homo sapiens | DEADMH (Asp-Glu-Ala-AspiHis) box po 287 4.96 4
16 |1 gil5611831 0refiNP_073566.2] el Hormo sapiens | nuclear ubiquitous casein kinase an 865 | 5582 1

In the first line of the quantification box you have to specify the modifications with have to be
compared (in this example a fixed modification is selected, therefore “no mod”, against a
modification at C-termDE with the value of 3.01). Then you can specify two thresholds to
display deviations from the 1:1 ratio in colour. “Normalize” means that a total ratio over all of
the peptides is calculated to see if there are any differences in the labelling efficiency and the
other values are corrected automatically with this value. This option takes a little bit longer
since a lot of peptides have to be fetched from the database. The option “Remove
incompletely modified” removes all peptides which do not carry a modification on all of the
possible positions. If you want to measure incompletely modified peptides do not use this
option.

There is a link on the ratio of the comparison which leads directly to the quantitative peptide
overview for this protein (see 7.8).



7.2 Cluster (Partitioning):

Partitioning

Clusters per page: [15] 25 50 100

4 Clusters found Page 1 of 1 go to page |:| go
Hr | Cluster Maximum score protein Sequences | Max score | Awg score Clustahnf

1| Cluster-0001 | Trypsin precursar a 0013 gogs N E = = 4 X
2 | Cluster-0002 | Keratin 1 [Homo sapiens] 2 0 0 BEEN- ﬂl X
3 | Cluster-0003 | albumin [Bos taurus] 2 3018317 | 2014285 OF |E|IE| ™ ﬂl X
4 | Cluster-0004 | Glycogen Phosphorylase b (EC.2 4. . 1 51846.46 | 51846.46 ﬁ 3_',-: = ! ; X

Clusters per page: [15] 25 50 100
4 Clusters found Page 1 of 1 go to page |:| go

Refresh | Return |

The detailed view of the clusters is reachable by the protein comparisons (7.1). The proteins
are sorted by the size of the cluster.

e : Download of the involved proteins in FASTA format
= : Download of the alignment of the proteins
[ : Download the storage of the tree that you can see in Jalview at the end of this section

= . The log-file of the alignment

Load |

: The £: buttons are Java applets itself and when you want to display a big list all
of the buttons all the applets would have to be loaded. As this takes to much
time, the Load” button has to be presses to get a corresponding applet.

£ : Starts Jalview applet to see the alignment
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id| 2 ¥\waspectras| 26437 Hssar -
id| 3lwaspeatas| 264 357|soore | 1-78]
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0.4 .
id|34|maspectras|264386|score|

0.11 0.44

id|38|maspectras| 264357 | score|

0.15 —10.44

id|21|maspectras|26437 3| score|

0.35 .
! id|2|maspectras|2643a60|score| 1

0.21 .
id|12|maspectras| 264364 | score|

n.1a )
id|10|maspectras| 264363 |score|

o4 0,13 .
— id|29|maspectras|264385|score|

0.0

0 007

id|4|maspectras|264354|score| 1
0.04

1010

id|3|maspectras| 264353 |score| 4



7.3 Clustering possibilities in MASPECTRAS:

The clustering settings in the clustered protein view can be made in the “Edit Display
Settings”. Generally it is possible to select clustering based on the protein sequence (the
possibility to show the alignment of the cluster is described at 7.2) or based on mass
spectrometry evidence. Since the mass spectrometry evidence based calculated on the fly,
no pre-calculation of the alignment is possible. Therefore the quick alignment algorithm
KAlign has been included.

Protein
Proteins per page: 15 [25] 50 100
8 Proteins found Page 10f 1 gotopage[  |go
Nr. | Acchr Organism | GeneName Gene Symbol | Domains %SegMax | Score | # Prots | # Peps | # Spec Enz | Ens | PbMd | SPrt
1 |IPI00383296 5 Isofarm 2 of Heterageneous nuclear | HNRNPM RRM 1578 | 352.22 2 ] 10 | @ ( Loadl C | er e | Mg
2 | IPID0220327 3 Keratin, type Il cytoskeletal 1 KRT1 1181 | 28410 1 7 7@ Lcﬂ C | ef v | A
3 |IPI00019359.3 Keratin, type | cytoskeletal 9 KRTQ 2.8 | 197.00 1 4 4@ Lcﬂ C | er |vm | Ay
4 |1PI00383111.2 57 kDa protein KRT10 542 | 9661 6 3 3| @ C |ef v | Ay
5 |IPID0021304.1 Keratin, type Il cyloskeletal 2 epi KRT2 497 | 99786 1 3 1| @ _L‘éil C | er | Ay
6 |IPIDD414676.6 Heat shock protein HSP 90-beta HSPQ0AB1 | HATPase_c 498 |128.19 8 k| 1| @ ’l;badl C | er v | Ay
7 | gilt36429 Trypsin precursor 1213 | 13387 1 2 3| @ Lnadl C | er | | Ay
8 |IPID0BO4620.3 Isoform 1 of Nucleolin NCL RRI 330 | 8462 4 2 2 | @ Luadl C | e! | | Ay
Proteins per page: 15 [25] 50 100 l£

8 Proteins found = Dl_xl

File Edit Select View Format Colour Calculate Help ge: 15 [25] 50

310 320 330 ¥
Export Current View: | PPI00853114/1-564 o

PPID000SBES1-593

PPI0037591 1/1-450
To Protein View == PI0032B10341-459

PPI00FIATIS 48T
To Peptide View > PPI0041E6EH1 988
Return |

The procedure to display the alignment is similar to 7.2. First the “Load” button has to be
pressed to start the alignment. When the Java icon appears you can click on it and the
Jalview Alignment editor will be started to show the results.

The system has further the ability to invoke more than one clustering sequentially (e.g.
first the proteins are clustered by MS evidence and then by the sequence). Further
clustering methods are planned in future.



=|| * Custening: [ Protgin Sequence

Save Settings

nieina perpage: 15 [25] 50 100
§ Proteins found Page 1 0l 1 . 9o topage[ oo

[! A tirgan Gene Symbol Domauns SSeqhtax Scone # Prats # Peps # Spec Enz  Ens | PoMad
HINRNPH RAM 1576 35222 1 g w| s e e |
KRT1 181 25410 (D] 7 7 e e |
Wr. | Acchr Organism | Genetame Gena Symbol | Domains | %SeqMax | Score | #Prots | #Peps | #Spec Enz | Ens | PoMd | SPrt
1| PI00220327.3 Keratn, e Il cioskeletal 1 KRT1 1181 | 25410 1 7 7T & e ke '
7 KRTY 98 | 1wroo 1 1 @ @ |gr e A
3 WRT1D saz | e | (_6) E 2 @ ef |ee |J
Detads trom E—a—""""’-‘_’
M. | Acch o Gene Gene Symbol | Domaine Sl Score | WPeps | 85 Enz
1 KRT10 543 2661 3 |E
KRT10 506 | 9681 e
KRTIS an 1 2 | &
KRTZT 383 4.51 <
KRT28 18 1 J[
KRTZ8 an 451 2 |2
Sequence x
m
L] ]
: KRTZ 497 | ea7s 1 3 3|@ @ |er | A
Sequenc *

This example shows a protein list which is first clustered by the mass spectrometry
evidence and then by the protein sequence. The second row has been expanded with the
blue button und the content of the cluster (4 proteins) is shown (clustering by protein
sequence). The protein at row three of the cluster is again the representative of a cluster
(clustered by MS evidence) which is again expanded by the blue button. The fourth
element of the first extended cluster will be continued after the extension of the cluster
with second cluster with six elements. Additionally this view has the ability to show the
peptides of a specific protein at the right side if you click on the number in the column
“# Peps”.

7.4 External information:

The system provides the possibility to directly link the found proteins to many external
sources. If you want to know how to configure the system to fetch the necessary external
information please visit section 2.1 and how you restart just the fetch (and not to do a
removal of the uploaded data and start the upload again) please visit section 7 at the
beginning.

The fields that should be shown can be set in the “Edit Display Settings” of the page. If
you hover the mouse over an external link a popup will open, where there are links to
external information. Normally the link is displayed by its ID while in some cases like
PubMed the description of link (in this case the title) is getting displayed. On the
accession number of the protein is a link on the primary fetch page for the external links
(in the example below IPI).



Protein

Available fields

Required Information
¥ AccessionNum ™ Synonyms [T Description I PredictedPi [T Cluster Nr.
¥ GeneName (small) [ Organism ™ Sequence ™ sequCowMax [T Search

™ GeneName ™ Amount of Peptides I Modifications T Score ™ ofumber
™ Hide Keratin [T AmountofSpectra [ PredictedMass W Nr. of Proteins [T Quantification
External links

¥ EntrezGene ¥ co ¥ iHop W Uniprotswissprot @ vega ¥ Prosite

¥ Ensembl ¥ PFam ™ Kegg W UniprotTrembl ¥ NCBITaxD W RefSeq

¥ EnsembiHavana ™ Pubmed ¥ Gen3D M PathoSign ¥ InterPre ™ GeneCard

1. Clustering: |M_assspgc Evidence _3_'¥j

Add Clustering

™ Gene Symbol
™ Domains{SMART)

Update | Displayall | Display default

Save Settings

Proteins per page:

® Query

15 [25] 50 100

¥ Edit Display

Settings

Quant-Setfings

10 Proteins found | Page1of1 | gotopage[ |go

&

Nr. | Acchr #Prots Enz | Ens | Hav | Go | Pim | PbMd | iHop sprt PSan | Vaa IPro | Prst GCd
1 | gil162648 albumin [Bos taurus] 5| @ ‘ﬁ] C |ef | s |60 v [nke | ¢ (7]
2 | IPID0440493 2 | ATP synthase subunit alpha, mitacho 4| @ M C | ef | me |60 v [rhe a2 | =]
3 | IPID0479186.5 | Isaform M2 of Pyruvate kinase isozy 10 |@ ||ioad] | @ | ef |4 |60 wa (ne | d | =]
4 | IPI00219005.3 | FK506-binding protein 4 1|@ __}l,l;i}t_] C | ef | |60 | wm [whe | |5 ]
5 | IPI00796844.1 | Full-length cDNA clone CS0CAPOOTYF s |@® ﬁ] C | ef | g |60 v [whe | dn =]
6 | IPI00807545.1 | Isoform 3 of Heterogeneous nuclear 4| @ ‘ﬁ] C | e! | aw |60 v [ i ]
7 | gil136429 Trypsin precursor 1@ Load || C | &f | a | GO | wam | h i
8 | IP100295400.1 | TryptophanyHRNA synthetase, cytop 2| @ _:Lﬂ;i}tj C et | aw |60 | v i
9 | IPI000252521 | Protein disulfide-isomerase A3 prec 3| @ ﬁ] C | ef | me |60 v =]
10 | IPI00290110.5 | Programmed cell death protein 4 2 | @ M C | ef | g |60 wa i
10 Proteins found | Pagetoft |

Export Current View:




7.5 Peptide comparison:

ABBOS serum albumin ® % EditDisplay %' Show

precursor [validated] - bovine B Sequence

2= HEA_S00MmolHE-T00fmolDE 3 = BEA_500fmolHE-500fmolDE
NI P = Y PR

Sequence X

MEWYTFISLLLLFSSAYSRGVYVFRRDTHKSEIAHRFKDLGEEQFKGLYLIAFSQYLQQGCPFDEHYKLYMNE
LTEFAKTCYADESHAGCEKSLHTLFGDELCKVASLRETYGDMAD CCEKGQEPERNECFLEHKDDSPDLPKL
KFDPMTLCDEFKADEKKFWGKYLYEIARRHPYFYAPELLYYANKYNGYFADCCQAEDKGACLLPKEIETMR
EKVLASEARQRLRCASIOKFGERALKAWSVARLSOKFPKAEFVEVTRKLYTDLTKVHKECCHGDLLECADD
RADLAKYICDMNOQDTISSKLKECCDKPLLEKSHCIAEYEKDAIPENLPPLTADFAEDKDVCKNYQEAKDAF
LGSFLYEYSRERHFPEYAVEVLLRLAKEYEATLEECCAKDDPHACYSTYFDKLKHLYDEPQMNLIKGQNCDGAFE
KLGEYGFOMNALIVMRYTRKVPOYSTPTLYEYERSLGKYGTRCCTHKPESERMPCTEDYLSLILMRLCYLHEK
TRPYSEKYTKCCTESLYNRRERFCFEALTPDETYYPKAFDEKLFTFHADICTLPDTEKQIKKGTALVELLKHK
PHATEEQLKTYMEMNFYAFYDKCCAADDKEACFAVEGPRKLYYSTGOTALA

[T allfound in Red

fixed modifications
BSA_S00fmolHE-1000fmolDE: Carbamidomethyl (C)
BSA_500fmolHE-100frmolDE:  Carbamidormethyl (2
BSA_A00fmaolHA-500fmolDE:.  Carbhamidomethyl () Compare Ratios of 2 Modifications
C-termDE™ 33.05 C-termDE@: 28.03 M%:15.99

Peptidehits per page: 15 [25] 50 100

105 Peptidehits found Page1of 5 Hext == go to page |:| qo
Search | Score | Sequence
¥ |3 91.35 | MUWPCTE@D&EYLSLILNR.& @
¥ |3 7542 | MPCTE@DEYLSLILNR.& @
W [123 71.02 | LGEaYGFONALNR.& @
W [123 7071 | LGE*YGFONALIVAR.® @
— PP A an B N £~

The gene-name is displayed at the page head. The E button opens the box with the
protein sequence again, if you have closed it. Below the page head the searches are listed
again. This time dyed in order to recognize them in the protein sequence. Underneath the
possible combinations of the searches are colour-encoded as well.

The “Sequence” box has a little checkbox “All found in Red”, which shows all found
parts of the sequence in red, if one colour is not easily visible.

Then the searches are listed again and the fixed modifications are given. At the end of the
searches the variable modifications are indicated in one row. The affected amino acids are
shown followed by the substitute for the modification in the peptide list and the mass shift
after the colon.

Below the searches the found peptides are listed, sorted by the score. To indicate by which
search the peptide has been found the numbers in the search column are denoted (the same
way like in 7.1). If this sequence is a first hit, the sequence is in bold letters. When you
uncheck the checkbox in front of a peptide, this peptide will be removed as found in the
“Sequence” box. At the upper right part of the peptides listed there is the link “Compare
Ratios of 2 Modifications”. Here you can compare the quantitative ratios of differentially



labelled proteins (e.g ICPL-light to ICPL-heavy), or all found peptides which carry a
modification versus ones that do not carry the modification (see 7.8).

When you push the blue @ button you get detailed information about a peptide. That
means you are on the level of the single searches. Here you get more detailed information
about the peptides. On that level the quantitative comparison is possible as well (the “Peak
Area” column).

Search | Score | Segquence Peakfrea
V|1 4559 | . TVM%E "NPYAFYD K. G
W |1 63.65 | .TVMUE@NPYARYD@K. @ @
V|1 3419 | VPOWSTPTLVE@VYSR.G@ G
W |1 4959 | VPOVWSTPTLVE*YSR.* o
V|1 24.34 | YICD@NQD@TISSK. @ G
W |1 4504 | YICD*NOD*TISSK.* @
V|1 26.62 | YICDNQD@TISSK. @ G
¥ |1 3454 | YLYE*IAR.* (i)
¥ |1 26.44 | YLYE@IAR.@ (i)
Peptidehits per page: [15] 25 50 100
69 Peptidehits found =< Previous Page 5of 5 go to page qo
Details from YLYEIAR X
Hr. | Search | Score | Sequence | Mass Delta Humlons | ParentCharge | Peakfrea
1 1 3505 | JYLYEMAR.* | 9893613782 | 0537291 |6 2 8.7043128E7
2 1 34.54 | YLYEMAR.* | 993613782 | 0197291 |6 2 8.7043128E7
3 1 33.37 | YLYEMAR.* | 993613782 |-0.022709 |6 2 8.7043128E7
4 1 28.85 | YLYEMAR.* 993613782 | 2497291 |5 2 5.7043128E7
Details from YLYEIAR x
Nr. | Search | Score | Sequence Mass Delta Humlons | ParentCharge | Peakfirea
1 1 3289 | YLYE@IAR.@ | 933556501 | 0.304572 |6 2 4. 1418732E7
2 1 32.88 | YLYE@IAR.@ | 933556501 | 0.564572 |6 2 4 1418732E7
3 1 26.44 | YLYE@IAR.@ | 933556501 | 0674572 |4 2 4 1418732E7

Return |

When you move your mouse over one entry of the column “Search”, “Sequence” or
“Score” a tooltip with the hits will be displayed.



Details from SGSLTFHNSK x

Mr. | Search | Score | Seguence Mass Delta Humlons | ParentCharge
1| 2 4803 | SGSLTFNSK. | 940.473935 0.777138 |7 2
2 2 4284 Franzz 0735.07372.dta 73935 | 2117138 | B 2
3| 1 |158z 9125 SGSISYLOR. 7y g 7503 2
48.03 .SGSLTFNSK.
4 1 [138 T . A74 | 21182 2

When you click on one of the entries with the tooltip a window pops up with the
corresponding spectrum, so that manual validation is possible (see 7.6).

When you click on the link on the peak area entries you receive a chromatogram viewer
for the manual inspection and correction of the automatically calculated peak areas (see
7.7.)

Concerning the querying:
The meaning of most of the query fields is clear by the name they carry. And most of the
query fields are executed as directly on the database which is quite fast. The queries that are
described here are post-database filters, that means that elements that do not meet the criteria
are removed later, which takes a little bit longer:
e NrOfPassingSpectra: a specific amount of spectra must be found for one peptide hit in
one search
e NrOfPassingFirstHitSpectra: a specific amount of spectra must be found for one
peptide hit in one search
e NrOfTotalPassingSpectra: a specific amount of spectra must be found for one peptide
hit in several searches
e NrOfTotalPassingFirstHitSpectra: a specific amount of spectra must be found for one
peptide hit in several searches




7.6 Spectrum View:
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With “Edit Display Settings” you can select the series you want to be displayed. You can
save your own display settings like in all the other pages.
With the select box below the “Edit Display Settings” box you can switch between the
found hits.
Then there is a Java Applet with the spectrum (see 7.6.1) and after the spectrum view a

box with calculated masses of the fragments is added. At the bottom of the page the mass

error of the single hits of the different series is displayed.



7.6.1 The spectrum viewer:
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The not assigned peaks are displayed in red. The assigned fragment name is written on the
top of the peak. If you hover your mouse over one peak the name will be displayed in a
tooltip as well. You can zoom into your spectrum and scroll the x-axis with the bar at the
bottom.

@ : zooms out the y-axis
& : zooms out the x-axis

@ : zooms out both axes

When you first click on the spectrum and then click with the right mouse button you will
get a popup window where you have additional features:
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You can print your actual zoom scan. In the “Properties...” you can customize your font
and other settings.

x
[ Title [ Legend | Plot | Other |

General:

Show Legend:
Outline; L @ | Select...
Outline paint: N | select...
Background: [ || Select...
Series label font: Select...
Series label paint: NN | Sclect...

OK Cancel

: Java Applet Window




7.7 Chromatogram viewer
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At the top the name of the peptide is written. The upper view shows the chromatogram plus
the chromatograms in the neighbourhood. The red peak is the quantified one the green peak
indicates one that has been selected manually. The second view shows one of the upper
chromatograms in a 2 dimensional view. The one chromatogram which has been selected is
shown in yellow in the upper view. The mass to charge ratio of the selected chromatogram is
shown in the yellow box on the right side of the upper view.

|Backmost mz= 651.70d
|Frontrost mz = 656.50d
| Total Area = 8.9642+06

+ (3ain

- Fain

The box at the upper right part of the upper view shows the m/z
borders where the chromatograms are depicted and the total area
calculated. With “+Gain” and “~-Gain” you can zoom in and out the
amplitude.
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In the menu on the right side you can determine how many chromatograms
you want to see in positive/negative m/z direction with “Upper mz
Span”/”Lower Mz Span”. With the mz Step you can select the distance
between two chromatograms. Peaks within one half of the distance in
positive direction and one half of the distance in negative direction are taken
for the calculation of the chromatograms.

Once you changed something there you must press the “Process Data”
button to retrieve the chromatograms from the server. The “Store Data”
button stores manually changes (additional or removed peaks). With the
“Charge” you can switch between the charge states of the peptide (only
found charge states are calculated). With the “-mz” and the “+mz” you can
select the chromatogram for the 2D view. With “Raw” and “Smooth” you
can see the smoothed chromatogram and the raw chromatogram. In the
“t[min]” and “t[max]” you can fill in the time borders and with “Zoom in”
you can zoom to this borders for the 2D view. Use “Zoom all” to go back.
The last check-box changes the quasi-3D view to real 3D viewer. The
problem is that the real 3D viewer needs Java3D installed on the client
machine and needs much more main memory on the machine (see 7.7.1)

The box at the upper right part of the lower view shows the current m/z
value, the time where the curser is actually and the amplitude where the
cursor is actually. With “+Gain” and “-Gain” you can zoom in and out.
With “<<” “>>” you can move in the zoomed view left and right.
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In the lower view you can select and deselect peak areas when you move the cursor inside the
peak area you want to select and click the right mouse button the popup will appear. With the
“Determine Area” you select a peak like it is chosen in ASAPRatio. With “Determine Area
(Col)” the new peak finding algorithm is taken which quantifies peaks with saddle-points and
foothills. The black “A=...” shows the stored area in the database the blue “A=...” shows the
actually selected area for that peak. If a peak with the same boundaries is stored in the
database the peak appears in red otherwise it is shown in green. At the bottom there is a
progress bar. When there “Done” appears you can work on the chromatograms, when
“Processing Data ... “ the applet is fetching data from the server and there is no use to work
on the data now because the data will be overwritten when it is finished.

7.7.1 Chromatogram 3D viewer:
To run the 3D-viewer Java3D must be installed. You can download this from:
http://java.sun.com/products/java-media/3D/download.html

When you installed Java3D you have to reserve more memory for the applet. In Windows you
have to go to “Control Panel” and then double-click on Java.
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Click on the Java tab and then in the Java Applet Runtime Settings on the “View” button. You
should enter approximately the values I entered here (at least —Xmx320m should be used) and
click on “OK”. Then it is necessary to restart your browser. Then in your browser it is
possible to check your Java Console:
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When you click in the Java Console on “m” you can check the memory used. The option
—Xms is the permanently reserved memory and the —Xmx is the maximum memory that could
be used if needed. When you start the Java3D viewer (clicking on the radio button Java 3D)
and you get java.lang.OutOfMemory you have to less memory to run the 3D applet.

Now to the 3D viewer:
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The memory used for this applet is mainly dependant on the resolution used and on effects
like “Show Light” or “Show Texture”.

With the “Update” buttons you execute your changed settings.

With “Stretch time” you can stretch or tighten the time coordinate. With “Stretch int.” you can
stretch or tighten the intensity coordinate. With “Stretch m/z” you can stretch the m/z axis.
With show lights you can have light effects and with “Show Texture” the surface is covered
with a texture. The light and texture option makes it easier to realize bumpiness on the
surface. The “Selected” option shows the selected peaks in red and green. The “2D-Position”
option shows the position of the 2D chromatogram displayed below in gold in the 3D
chromatogram. On the right menu you can specify how the time and the m/z axis should be
resolved. Here in this example I used two resolutions depending on the distance to the object.
When you come nearer it will automatically switch to a higher resolution.



Update

1000

Close resolution:

Stretch time: hiint.. igh ad ol ew | Update

t: time in seconds which is used for one data point
m/z: m/z distance which is used for one data point

d: distance to the chromatogram object to switch to a higher resolution (has nothing to do with
m/z or t).

The user can store for himself his own resolution settings and the rest of the settings described
here with “Save Settings”. The “3D is default view” option has just an effect when you click
afterwards on “Save settings”. When you checked this option, the next time you open a
chromatogram viewer applet the 3D view will be used automatically.



Be careful with the resolution settings because they are causing the memory consumption of
the applet. When you first visit the 3D view an automatic setting is calculated, which is
adjusted to your data. When you once stored your own settings, these automatic settings will
never be called again. So be careful when you first took a look at high resolution data (in a
smaller range) and switch then to low resolution data (in a broader range). The viewer will
still use the high resolution settings (if you did not save different ones) and run out of
memory. Once the Java Console runs out of Memory all the browser windows have to be
closed and the browser must be restarted. Very often the Java Console is still causing
problems. The best is, once a browser window is opened to open the Java Console before any
page is visited (then I have never problems). For this applet I had the experience that the
Firefox browser is better, since for the Firefox more memory can be allocated for applets than
the IE.

7.8 Evaluation of quantitative ratios

When you click on the link “Compare Ratios of 2 modifications” in the peptide list you come
to the following view:

Select two modificatio

Search

[T | M-termxk® 111.04

[T | N-termkg: 105.02

r #M%: 1599

Accent |

Her all the possible variable modifications are listed. You can select one ore two between
them you want to calculate ratios and click the “Accept” button.

(See next figure) At the upper left the selected searches are listed and a number for them.
Then you have a list of your comparable peptides. In the first column you can select and
deselect the peptide, the second columns indicates the search which is compared, the third
column is the peptide sequence which is compared, the fourth column shows the charge states
which are comparable, the fifth column shows the area for one modification, the sixth for the
other one, the seventh and the eighth column shows the ratios of the areas to one another. At
the end of the column the mean and the standard deviation of the selected values is calculated.
The whole list can be exported to Excel, Doc and txt. At the bottom of this is a link called
“Refresh areas” which refreshes the list when you changed quantified areas manually. The
picture depicts the found ratios graphically and calculates a regression line for the values. On
the one axis the area for one modification and on the other to area for the other modification is
depicted. The picture can be copied directly out of the browser.
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Sequence Z H-termXK*: 111.04 N-termXKio: 105.02 Ratio 1/2 Ratio 211

v ALKFRNEVAR. 2 8856610.6171875 8761861.0 1.0108138690156692 0.9893018197047497
7 ALKFANEVAR. 2 954261275 9225358.75 1.0343893401435473 0.9667539689274303
I ALKFANSVAR. 2 1.0170150546875E7 9550851.375 1.0648423001844691 0.9391061942475086
7 (CASIQKTFGER. 3 876386.25 958544125 0.9142888961945284 1.0937461935305353
Ird (CASIQK*FGER. 2 932372259375 9311852.25 1.0012747564535294 0.9987 268664816393
r CLEFDGAGDVARVI 2 128293.22 BE1789.1 0.19385816417949464 5.15841055357407
r CLEFDGAGDVARVI 2 19519817 6348949 0.30744957945007906 | 3.2525658411654166
r CLVERFGDWARYI. [if} 0.0 RE MNaM
I CLVERFGDWARYI 2 1307267.75 1664997 8046875 0.7851468310166081 1.2736471198708146
v CLVERFGDWARWEL 2 1318871.453125 14597522 0.9041750052680174 1.1059805835968424
I DDTWCLAKLHDR 2 2808382.15625 2191846.390625 1.2812860281915999 0.7804658585182535
7 DHMEFSVIPSDGPSWACYIC 2 164365.38 166958.88 0.9844662350394301 1.0157788702219408
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